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1 Wichtige grundlegende Informationen 

1.1 Benutzung dieser Betriebsanleitung 

Die vorliegende Betriebsanleitung beschreibt vollständig alle Optionen zur Bedienung des 
flashtransver vario HD (im folgenden „vario HD“ genannt). 
Bitte beachten Sie auch die „Verantwortlichkeiten des Betreibers“ [S.7] sowie die „Rechtli-
chen Hinweise“ auf Seite 8. 

Zur Kennzeichnung wichtiger Textabschnitte werden folgende Symbole verwendet: 
 

 

Warnung oder Verbot! 

Die Nichtbeachtung dieses Hinweises führt zu schweren Fehlern am Gerät, 
zu gesundheitlichen oder Produkt-Schäden! 
Gegebenenfalls erlischt die Herstellergarantie! 

 

 

Bitte beachten! 

Dieser Hinweis gibt Ihnen wichtige Informationen zur Vermeidung von Fehl-
funktionen oder unerwünschten Resultaten beim fertigen Produkt. 
 

 

Zusatz-Information 

An dieser Stelle erhalten Sie Hinweise für ein effektiveres Arbeiten sowie 
weiterführende Informationen für ein umfassenderes Verständnis der Funk-
tionsweise des Geräts. 

 

Angaben zu Menü-Punkten in der Bediensoftware werden angegeben in der Form 

„Hauptmenü -> Unterpunkt [-> weiterer Unterpunkt]“ 

 

In der Betriebsanleitung werden folgende Fachbegriffe und Abkürzungen verwendet: 
 

HD High Definition: Bildformat mit einer Auflösung von 
1.920x1.080 Pixeln („1080i“) bzw. 1.280x720 Pixeln („720p“) 

(HD)SDI Serial Digital Interface: serielle digitale Schnittstelle 
zur Übertragung von Videodaten (HD/SD) 

LUT Look Up Table: Wertetabelle zur Übersetzung zwischen analogen und digitalen 
Baugruppen, speziell zur Übertragung von Farbwerten auf Film 

PTR Particle Transfer Roller: Filmreinigungsrolle 

RGB Red Green Blue: Farbraum, der aus den Anteilen für Rot, Grün und Blau entsteht 

USB Universal Serial Bus: standardisierte serielle Schnittstelle zu externen Geräten 

YUV Farbraum, der aus den Anteilen Luminanz (Y) und Chrominanz (U+V) entsteht 
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1.2 Lieferumfang 

Das varioHD-System wird in zwei zusammengehörigen Funktionseinheiten geliefert: 

1. varioHD-Grundgerät  

2. Anwendersoftware zur Geräte-Bedienung (im folgenden „Bediensoftware“ genannt) 

Zusätzlich wird diese Betriebsanleitung ausgeliefert. 

Gegebenenfalls auf Kundenwunsch zusätzlich gelieferte Baugruppen oder Geräte sind nicht 
Gegenstand dieser Betriebsanleitung und fallen in eine gesonderte Verantwortlichkeit. 

Nicht im Lieferumfang enthalten sind Geräte, die zur weiteren Verarbeitung der vom varioHD 
generierten Videosignale erforderlich sind wie z.B. Rechner, Videorecorder usw. 

1.3 Verantwortlichkeiten 

1.3.1 Verantwortlichkeiten des Herstellers / Konformität 

Der Hersteller 

MWA Nova GmbH 
Zillestr. 7-11 
D-10585 Berlin im folgenden „MWA“ genannt 

erklärt hiermit, 

dass das Produkt „varioHD“ 

den Bestimmungen der Maschinenrichtlinie 98/37/EG – einschließlich deren zum Zeitpunkt 
der Erklärung geltenden Änderungen – entspricht. 

Die Technische Dokumentation "Betriebsanleitung" steht zur Verfügung. Sie dokumentiert 
die Übereinstimmung des oben bezeichneten Produkts mit den nicht angewendeten Teilen 
der anwendbaren harmonisierten Norm. 

Berlin, den 17.01.2012 

 

_______________________________ 

Frank Ortwein, Geschäftsführer 
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The product flashtransfer vario complains with regulations of 

FCC 47 Part 15 Sec 15.105 Class A 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference, and (2) this device must ac-
cept any interference received, including interference that may cause undesired operation. 

Note: This equipment has been tested and found to comply with the limits for a Class A digi-
tal device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reason-
able protection against harmful interference when the equipment is operated in a commer-
cial environment. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is 
likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense. 

Warnung! 

Dieses Gerät ist eine Einrichtung der Klasse A. 
Diese Einrichtung kann im Wohnbereich Funkstörungen verursachen. In diesem Fall kann 
vom Betreiber verlangt werden, angemessene Maßnahmen durchzuführen. 

 

1.3.2 Verantwortlichkeiten des Betreibers 

Die vorliegende Betriebsanleitung wurde mit großer Sorgfalt und unter Wahrung der erfor-
derlichen Prüfungen erstellt. Dennoch sind Fehler nicht auszuschließen. Daher liegt es in der 
Verantwortung des Benutzers, die gegebenen Erläuterungen und Anweisungen bestim-
mungsgemäß und angepasst an die realen Verhältnisse umzusetzen. Für Schäden, die durch 
eine nicht eigenverantwortliche und der technischen Logik nicht entsprechende Handhabung 
entstehen, übernimmt die MWA keine Haftung! 
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1.4 Rechtliche Hinweise 

Für Lieferung und Inbetriebnahme des Gerätes sowie Garantieleistungen gelten die Allge-
meinen Geschäftsbedingungen der MWA (www.mwa-nova.com/contact-terms.htm). 

An dieser Stelle werden nur einige ausgewählte und allgemeine Grundsätze beschrieben. 

Die MWA garantiert im Rahmen der gesetzlichen Bestimmungen eine einwandfreie Funktion 
des Gerätes in seinem standardmäßigen Lieferumfang [S. 6]. Der Einsatz zusätzlicher Geräte 
und Baugruppen (ausdrücklich auch solcher, die von MWA erworben wurden) zusammen mit 
dem varioHD geschieht auf eigene Verantwortung und Gefahr des Anwenders. 

Voraussetzung für eine Garantieleistung ist eine sachgemäße Verwendung des Gerätes ent-
sprechend den in dieser Betriebsanleitung gegebenen Hinweisen sowie die Bedienung seitens 
eines von MWA geschulten Fachpersonals. 

MWA leistet im Rahmen der gesetzlichen Frist von 6 Monaten ab Kaufdatum kostenlose Ga-
rantieleistungen, wenn Fehlfunktionen auf Baumängel oder Materialermüdung zurückzufüh-
ren sind. Im Anschluss an den Garantiezeitraum übernimmt die MWA Gewährleistungsleis-
tungen. Voraussetzung hierfür ist eine bestimmungsgemäße Verwendung entsprechend den 
Hinweisen aus dieser Betriebsanleitung. Fehlfunktionen, die nach Notabschaltungen der Ge-
räte oder Stromausfall auftreten, fallen nicht unter die Garantie. 

Ebenso übernimmt MWA keine Garantieleistungen aus Fehlern, die auf eine über die in die-
ser Betriebsanleitung hinausgehende Verwendung weiterer Soft- oder Hardware basieren, 
selbst dann, wenn diese auf Kundenwunsch seitens der MWA geliefert oder eingerichtet 
worden sind. 

Alle Garantieleistungen erstrecken sich jedoch nur auf den Ersatz oder die Reparatur des 
Gerätes bzw. seiner Baueinheiten sowie die damit verbundenen Aufwendungen, insbesonde-
re Transportkosten. MWA übernimmt keine Ersatzleistungen für entgangene Umsatzeinnah-
men des Anwenders, Materialverluste (insbesondere verbrauchtes Filmmaterial) oder even-
tueller Forderungen Dritter, z.B. aufgrund entstandener Produktionsverzögerungen. 

Gerichtsstand und Erfüllungsort ist Berlin (Deutschland). 
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1.5 Serviceadresse 

Für Hilfestellungen und Serviceanforderungen stehen wir Ihnen gern zur Verfügung 

 

Montag bis Freitag: 9:00 – 18:00 

Service-Telefon: +49-30-3980 190-0 

Mail: support@mwa-nova.com 

 

Sie erreichen uns außerhalb der Geschäftszeiten 

 

per FAX: +49-30-3980 190-99 

per Mail: info@mwa-nova.com 

per Post: MWA Nova GmbH 
Zillestraße 7-11 
D-10585 Berlin 
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2 Sicherheit 

Die Einhaltung der folgenden Sicherheitshinweise und Bestimmungen garantiert nicht nur die 
zugesicherte Funktionsweise des Gerätes sowie den Schutz der Gesundheit und Sicherheit 
des Betreibers, sondern ist unbedingte Voraussetzung für kostenlose Gewährleistungen sei-
tens MWA im Fall von Fehlfunktionen. 

Für den varioHD gelten die allgemein üblichen Sicherheitsstandards, wie sie auch bei anderen 
Büro- und kinotechnischen IT-Geräten Anwendung finden. Es sind darüber hinaus keine spe-
ziellen Vorkehrungen erforderlich, um das Gerät zu starten, zu bedienen und herunterzufah-
ren. 

2.1 Verhalten im Notfall 

Bei unvorhergesehenen Verhaltensweisen des varioHD oder äußeren Notfallsituationen kön-
nen Sie das Gerät durch Drücken eines der beiden Load-Stop-Schalter sofort stoppen (vgl. 
Abbildung 1: Vorderansicht [S.14]). 

In extremen Notfällen ist auch eine Abschaltung durch Betätigen des Netzschalters oder ein 
Ziehen des Netzsteckers am varioHD oder bzw. anderweitige Unterbrechung der Stromzufuhr 
möglich. 

In jedem der genannten Fälle gehen jedoch alle nicht gespeicherten Daten verloren! 
Ein in diesem Moment noch laufender Scanjob muss später komplett wiederholt werden, 
da alle für eine Wiederaufnahme notwendigen Informationen nicht mehr zur Verfügung 
stehen. Außerdem können durch eine unkoordinierte Abschaltung unvorhersehbare Fehler 
an einzelnen Baugruppen auftreten. 
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2.2 Bestimmungsgemäße Verwendung der Maschine 

2.2.1 Einsatzbereich 

Der varioHD dient der Übertragung von 16mm- und 35mm-Filmbildern (ggf. inklusive Ton) in 
digitale Videosignale. 

Das Gerät darf nur für gewerbliche Zwecke eingesetzt und durch geschultes Personal be-
dient werden. 

Die Weiterverarbeitung der Videosignale, insbesondere die Umwandlung in Videodateien, 
muss auf einem geeigneten Rechner erfolgen. Hierzu erforderliche Hard- und Software sowie 
deren Funktionen sind nicht im Lieferumfang enthalten und daher nicht Gegenstand dieser 
Betriebsanleitung. 

2.2.2 Anforderungen an das Personal 

Die Bedienung des varioHD sollte nur durch Personal erfolgen, das von MWA hierfür geschult 
wurde. Ersatzweise kann auch eine Schulung durch Dritte erfolgen, wenn diese von MWA 
dafür autorisiert wurden. Darüber hinaus sind Grundkenntnisse im Umgang mit Filmmaterial, 
filmtechnischen Geräten, Computern sowie Erfahrungen auf dem Gebiet der digitalen Bild-
verarbeitung notwendig. 

2.2.3 Umgebungsbedingungen 

Um eine sichere Funktion des Gerätes zu gewährleisten, sind die folgenden physikalischen 
Bedingungen einzuhalten: 

Netzanschluss 100…240V (50Hz…60Hz) Typenschild beachten! 

Leistungsaufnahme max. 660W, durchschnittlich 150W 

Schutzklasse Schutzklasse I gemäß VDE 0804 
Netzstecker nur in Schutzkontaktsteckdosen einführen! 
Jede Unterbrechung des Schutzkontaktes ist unzulässig! 

Relative Luftfeuchtigkeit 40%...60% 

Raumtemperatur 15°C…25°C (60°F…95°F) 
klimatisierter Raum empfohlen 

Raumgröße mind. 3,0m x 2,0m x 2,5m (L x B x H) 

Wandabstand mind. 0,2m nach allen Seiten 

2.2.4 Sicherheitsrelevante Hinweise 

2.2.4.1 Aufstellbedingungen  

Der varioHD ist für Räume konzipiert, die für den Betrieb datenverarbeitender und filmtech-
nischer Geräte eingerichtet, insbesondere aber trocken und staubfrei sind. Besonders ist da-
rauf zu achten, dass der varioHD auf ebenem, festem, nicht nachgiebigem Untergrund aufge-
stellt wird. Dieser sollte frei von elektrostatischen Einflüssen sein. Das Gerät darf nicht in der 
unmittelbaren Nähe von Hochfrequenzfeldern oder Hochspannungsanlagen aufgestellt wer-
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den. Darüber hinaus muss eine ausreichende Luftzirkulation möglich sein, die Raummaße 
sollten 3,0m x 2,0m x 2,5m (L x B x H) nicht unterschreiten und zu allen Seiten ist ein Min-
destabstand von 0,2m zu gewährleisten. Darüber hinaus sollten die Richtlinien beachtet wer-
den, die für Räumlichkeiten gelten, in denen Filme gelagert und verarbeitet werden. Insbe-
sondere darf die relative Luftfeuchtigkeit nur im Bereich zwischen 40% und 60% liegen. Zu 
große Trockenheit führt zu einer Austrocknung und Schrumpfung des Films, zu hohe Feuch-
tigkeit lässt diesen aufquellen. Eine Klimatisierung und Zwangsbelüftung des Raumes ist nicht 
zwingend erforderlich, wird aber empfohlen. 

2.2.4.2 Aufstellung, Inbetriebnahme  

Die Inbetriebnahme des Systems sollte nur durch Service-Mitarbeiter der MWA oder dafür 
autorisiertes Personal vorgenommen werden! 

Gleiches gilt für eventuelle Deinstallationen, Abtransporte usw. Diese Tätigkeiten sind Teil 
der Gesamtleistung seitens MWA im Zusammenhang mit dem Erwerb oder Rückkauf der 
Geräte. Eigene Aktivitäten des Anwenders in diesen Phasen führen zum Verlust noch vorhan-
dener Garantieansprüche! 

2.2.4.3 Vorsichtsmaßnahmen während des Betriebs  

- Halten Sie die Kamera-Abdeckung (siehe Abbildung 1 [S.14]) bei allen Arbeiten stets 
geschlossen, um Schäden an der Optik zu vermeiden. 

- Greifen Sie während des Betriebs niemals in den Bereich der Filmführung oder der 
bewegten Filmspulen! Sie können sich dadurch erhebliche Verletzungen, insbeson-
dere Schnittwunden und Quetschungen zufügen! 

- Vermeiden Sie während des Betriebs die Berührung aller beweglichen Teile durch 
Haare oder Kleidungsstücke. Durch Mitnahme an bewegten Bauteilen können Sie 
sich dadurch schwere Verletzungen zuziehen. 

- Das Gerät enthält konstruktionsbedingt offene Gehäuseteile. Berühren Sie im ein-
geschalteten Zustand niemals die dadurch eventuell zugänglichen elektrischen und 
mechanischen Bauteile im Innern! Es besteht neben einer möglichen Beschädigung 
des Geräts vor allem die Gefahr von Stromschlägen und äußeren Verletzungen. 

- Öffnen Sie das Gerät nicht! Dies darf nur durch Fachpersonal erfolgen, das von 
MWA dazu autorisiert wurde. Es besteht die Gefahr eines Stromschlags!  

- Ändern Sie keine mechanischen oder elektrischen Einstellungen am Gerät, es sei 
denn, diese werden in der vorliegenden Betriebsanleitung explizit beschrieben. 
Dies gilt insbesondere für die Justage der Optik – ändern Sie dort insbesondere 
nicht die eingestellte Blendenzahl, Belichtungszeit usw. Andernfalls können Fehler 
in der Bildwiedergabe auftreten. 

 

Achtung! 

Das Gerät arbeitet mit einem Laser der Klasse 1. 
Laserstrahlen können beim Auftreffen auf das ungeschützte Auge schwere und 
irreversible Schäden verursachen! 
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3 Technische Daten 

Gewicht 45 kg 

Maße (Breite x Tiefe x Höhe) ohne Filmspulen : 1.280mm x 448mm x 1.305mm 
inkl. Filmspulen: max. 1.580mm x 448mm x 1.305mm 
(max. Filmspulen-Durchmesser: Ø530 mm 

Netzanschluss 100…240V (50Hz…60Hz) 

Leistungsaufnahme max. 660W, durchschnittlich 150W 

Filmlänge bis 1.200 m (4.000 ft) 

Filmmaterial (Input) 35mm mit/ohne Tonspur 
16mm mit/ohne Tonspur 

Ausgabesignal (HD)SDI, Audio embedded oder AES/EBU 

Bildformate (Output) SD 4:3 576i (720 x 576 Pixel, 50 Halbbilder) 
SD 16:9  576i (720 x 576 Pixel, 50 Halbbilder, anamorphotisch) 
HD 720p50 (1.280 x 720 Pixel, 50 Vollbilder) 
HD 1080i50 (1.920 x 1.080 Pixel, 50 Halbbilder) 
HD 1080p25 (1.920 x 1.080 Pixel, 25 Vollbilder) 

Farbtiefe 3 x 10bit YUV 

Scanning-Geschwindigkeit (fps) Preview: 50…300 (35mm), 50…800 (16mm) 
Scanning: 4,166…25 

Filmantrieb Capstan (DC-Scheibenläufermotor), ohne Zahnrollen 
PTR Filmreinigungsrollen (optional) 

Beleuchtung RGB-LED, Farbwerte einstellbar 

Kamera 3-Chip 
Zoom und Schärfe motorgesteuert 

Anschlüsse 2 x HD-SDI (Audio embedded) mit Bild-Vorverarbeitung 
1 x HD-SDI (Audio embedded) unformatiert 
Sync: B-/Tri-Level Input, Biphase GPIO 
Audio AES/EBU 
USB 

Bedienung Filmeinlegen manuell 
Filmformat-Einstellung (16mm/35mm) manuell 
Gerätesteuerung über Anwendersoftware (GUI) 

 

Für die externe Hardware (nicht im Lieferumfang) gelten folgende Empfehlungen: 

- Referenz-Monitor 

· Broadcast-Class-1-Monitor oder gleichwertiger, HD nativ 

- Editing-Computer 

· Grafikkarte mit einer Auflösung von mind. 1.920 x 1.080 Pixeln (HD nativ) 

· Video-Raid (Raid-Level 0, mindestens 4 Festplatten) 

· Capture-Karte SDI 

- Control-Computer 

· Grafikkarte mit einer Auflösung von mind. 1.024 x 768 Pixeln 

· USB 2.0 

- Betriebssystem 

· Windows XP/Vista, Mac oder Linux. 
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4 Aufbau und Funktion 

 

Abbildung 1: Vorderansicht 
 

1. Quell-Spule 

2. Load-Stop-Schalter für Quell-Spule 

3. PTR-Filmreinigungsrollen (optional) 

4. Perforations-Sensor (Laser) 

5. Signal-Lampe (siehe „Event-Messaging“ [S.52]) 

6. Kamera-Abdeckung mit Arretierungsschraube 

7. Optik 

8. Filmgate mit Lüfter 

9. Lichtquelle (Lampenhaus) 

10. Capstan (Filmantrieb) 

11. Load-Stop-Schalter für Ziel-Spule 

12. Tonkopf 16mm 

13. Tonkopf 35mm 

14. PTR-Filmreinigungsrollen (optional) 

15. Ziel-Spule 
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Abbildung 2: Rückansicht 

 

1. Netzschalter 

2. Netzstecker 

3. (HD)SDI-Ausgang 1 

4. (HD)SDI-Ausgang 2 

5. (HD)SDI-Ausgang 3 

6. (HD)SDI-Ausgang 4 

7. Genlock IN 

8. USB 2.0 

9. Audio Analog OUT Left 

10. Audio Analog OUT Right 

11. Audio Analog IN Left 

12. Audio Analog IN Right 

13. Audio AES/EBU IN/OUT 1 

14. Audio AES/EBU IN/OUT 2 

15. Audio AES/EBU IN/OUT 3 

16. Audio AES/EBU IN/OUT 4 

17. RS 422 

18. GPIO 
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Der varioHD dient der Übertragung von 16mm- und 35mm-Filmbildern (ggf. inklusive Ton) in 
digitale Videosignale. Jede Weiterverarbeitung dieser Signalströme muss in externen Geräten 
erfolgen. Die folgende Abbildung 3 veranschaulicht dieses Zusammenspiel. 

 

Abbildung 3: Systemintegration 

Die Schnittstellen haben folgende Funktionen: 

- (HD)SDI 1 / (HD)SDI 2: 
Vorverarbeitete Videosignale der gescannten Filmbilder (mit eingebettetem Tonsig-
nal). Die hier ausgegebenen Bildinformationen sind entsprechend den Einstellungen 
formatiert, die in der Bediensoftware (GUI) festgelegt wurden. 
Dies betrifft: 

· Format (Aspect Ratio: SD 4:3 / HD 16:9, anamorph) 
· Bildgröße (Masking) 
· Farbe (B/W, Color Correction, Black, Gamma, Light) 
· Bildinhalt (Crisp, Detail) 

- (HD)SDI 3/4: 
Reines Videosignal der gescannten Filmbilder (mit integriertem Tonsignal) ohne Vor-
verarbeitung (mit Ausnahme der Negativ-Positiv-Umschaltung). 

Achtung! 
Auf diesen Kanälen erfolgt die Ausgabe stets im vollen Videoformat 1.080i50. 
Eventuell eingestellte Bildbegrenzungen und Farbkorrekturen (siehe „6.2.2 Bild-
format festlegen“ [S.29]) werden hier nicht wirksam! 

- AES/EBU: 
digitales Mono-/Stereo-Tonsignal 
In den varioHD eingespeiste Tonsignale werden als embedded Sound im SDI-Signal 
ausgegeben 

- Genlock: 
Tri-Level-Sync (Studio-Takt) 

- Biphase GPIO: 
Kanal zur Synchronisierung zwischen varioHD und externen Studio-Geräten, z.B. 
MWA MB51 für 2streifige Abtastung Bild und Ton 
(GPO und GPI frei programmierbar)  

- USB: 
Verbindung zwischen varioHD und dem Rechner (Control-Computer), auf dem die 
Bediensoftware läuft (GUI). 
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5 Aufstellung und Anschluss des Gerätes 

Dieser Abschnitt behandelt die erforderlichen Tätigkeiten nach einem innerbetrieblichen 
Transport, nicht jedoch eine Erst-Inbetriebnahme, die nur von MWA vorgenommen werden 
darf (vgl. 2.2.4.2 „Aufstellung, Inbetriebnahme“ [S.12]). 

5.1 Innerbetrieblicher Transport und Aufstellung 

Bei einem Transport des varioHD sollten aufgrund seines Gewichts grundsätzlich zwei Perso-
nen agieren. 

Vor jedem Transport sind der varioHD abzuschalten sowie alle Netzverbindungen zu trennen. 
Darüber hinaus sollten eventuell noch aufgesetzte Filmspulen abgenommen werden. 

Achtung! 
Vor jedem Transport muss die Kamera arretiert werden! 
Stellen Sie hierfür auf der GUI „Zoom“ und „Focus“ auf Null sowie „Pan“ auf Maximum 
[S. 29]. Dadurch fährt die Kamera in eine Sicherungs-Position (maximale Entfernung vom 
Filmgate). Andernfalls kann es zu Schäden an der Optik oder der Kamera selbst kommen. 

In jedem Fall muss der Transport auf ebener Fläche, erschütterungsfrei, in aufrechter Gerä-
teposition und in trockener Umgebung erfolgen! 

Der varioHD sollte über längere oder unebene Strecken ausschließlich mit einem geeigneten 
und gedämpften Wagen transportiert werden. 

Für die Aufstellung gilt das unter 2.2.4 „Sicherheitsrelevante Hinweise“ [S.11] gesagte. 

5.2 Installation der Bediensoftware (GUI) 

Die mitgelieferte CD enthält die zum varioHD gehörige Software (GUI). 

Das Gerät wird fast ausschließlich über die Bediensoftware gesteuert! 
Lediglich folgende Einstellungen werden am Gerät vorgenommen: 

- Ein- und Auslegen des Films 

- Umschaltung der Perforationsposition am Laser [S. 21] 

- Ein- und Ausschalten des Gerätes [S. 18] 

Zur Installation ist die CD im entsprechenden Laufwerk des Control-Computers (Abbildung 3 
[S.16]) einzulegen und den dann folgenden Anweisungen auf dem Bildschirm zu folgen. 

Nach Abschluss der Installation wird die Bediensoftware durch Doppelklick auf das Desktop-
Symbol gestartet. 

Mit dem Scanning der Filme kann begonnen werden, wenn mindestens folgende Verbindun-
gen am varioHD hergestellt sind: 

- USB zum Control-Computer 

- (HD)SDI zum Editing-Computer und/oder Reference-Monitor 
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5.3 Anschluss und Einschalten des Gerätes 

Alle erforderlichen Anschlüsse des varioHD befinden sich auf der Rückseite des Gerätes (siehe 
Abbildung 2 [S.15]). 

Vor Inbetriebnahme sind mindestens folgende Verbindungen herzustellen (vgl. Abbildung 3 
[S.16]): 

- USB zum Control-Computer 

- (HD)SDI1…4  zu Reference-Monitoren 

- Netzkabel 

Optional können weitere Anschlüsse erfolgen (siehe Abbildung 2 [S.15]): 

- Audio Analog von und zu einem analogen Ton-Wiedergabe- oder 
  Aufzeichnungsgerät 

- AES/EBU zu einem Tonaufnahme-Gerät oder Lautsprecher 

- GPIO  zu einem weiteren Studio-Gerät 
  das mit dem varioHD synchronisiert werden soll 

- RS422 zum Schnittsteuersystem 

Danach kann der varioHD über den Netzschalter in Betrieb genommen werden. 

Anschließend starten Sie die Bediensoftware. Sie nimmt Kontakt zu dem Gerät auf, was die-
ses durch einen Signalton bestätigt. 

Wenn die Software vor dem Einschalten des varioHD gestartet wurde, muss sie manuell 
über das Menü „File -> Connect“ mit dem Gerät verbunden werden. 

5.4 Ausschalten des Gerätes 

Der varioHD wird über den Netzschalter auf der Geräterückseite ausgeschaltet (vgl. Abbil-
dung 2 [S.15]). 

Vor Abschalten des Gerätes sollten alle Arbeiten beendet sein und sich die Maschine im 
Stopp-Modus [S. 24] befinden. 

Weitere Vorkehrungen vor dem Abschalten nicht erforderlich. 

Es empfiehlt sich außerdem, eventuell noch eingelegten Film umgehend zu entfernen, weil 
dieser sonst durch langes Verbleiben in der Filmführung verformt werden könnte. 
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6 Bedienung 

6.1 Einrichten 

Hinweis: 
Im Folgenden werden auch Elemente der Bediensoftware beschrieben. Dort findet sich an 
verschiedenen Positionen der Button . Mit diesem können Sie (ohne weitere Rückfrage) 
alle Einstellungen der entsprechenden Rubrik auf den jeweiligen Standardwert zurücksetzen. 

6.1.1 Film einlegen 

Das Einlegen des Films erfordert maximal fünf Schritte in nachstehender Reihenfolge. 

6.1.1.1 Filmgate  wechseln 

Dieser Schritt ist nur notwendig, wenn zuvor ein Film mit anderem Format gescannt wurde. 

Achten Sie darauf, während dieses Vorgangs weder die Optik der darüber befindlichen Ka-
mera noch die Glasabdeckung des darunter liegenden Lampenhauses zu berühren! 

Fahren Sie die Kamera in die Sicherungs-Position! 
Hierzu müssen Sie mit dem Steuerprogramm die Werte für „Zoom“ und „Focus“ auf Null stel-
len [S. 29]. Dadurch fährt die Kamera in eine maximale Entfernung vom Filmgate. 

Gehen Sie für den Ausbau des Filmgates wie folgt vor (siehe Abbildung 4 [S.20]): 

1. Lösen Sie die Arretierung des Lampenhauses und fahren Sie dieses ganz nach unten. 

2. Lösen Sie die Flügelschraube links des Lampenhauses 

3. Lösen Sie die Inbus-Schraube rechts des Lampenhauses 

4. Erfassen Sie das Gate inklusive des Lüftergehäuses und heben Sie es nach oben aus 
der Verankerung. 

5. Lösen Sie das Stromversorgungskabel für den Lüfter. 

Der Einbau erfolgt in umgekehrter Reihenfolge.  
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Abbildung 4: Ausbau des Filmgates 

6.1.1.2 Filmlauf  festlegen 

Für 16mm-Film muss der Teller beider Spulen bis zum Einrastpunkt nach vorn gezogen, für 
35mm-Film entsprechend nach hinten gedrückt werden. 

Bei 35mm-Film, der auf einer Spule gewickelt vorliegt, ist es erforderlich, beide Teller abzu-
nehmen, um die mechanische Dicke der Trägerspule auszugleichen. Andernfalls wird der Film 
nicht exakt in der Filmführung liegen. 

Ist der Film auf einem Bobbin aufgewickelt, dann müssen Sie zuvor den dafür mitgelieferten 
Adapter auf die Spule stecken. Andernfalls kann das Gerät den Film nicht bewegen. 

Legen Sie den zu scannenden Film grundsätzlich auf der linken Seite des varioHD ein und 
führen Sie ihn danach entsprechend der roten Linie in Abbildung 1 [S.14] in die Filmführung. 

Sollten Sie zusätzlich die PTR-Filmreinigungsrollen verwenden wollen, dann muss der Film 
entlang des gelben Pfades eingelegt werden. 

Die Wickelrichtung auf der Ziel-Spule können Sie frei wählen – sie wird später dem varioHD 
mitgeteilt. 
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Bitte beachten Sie, dass der eingelegte Film auf Anfang gerollt ist. Bei 16mm-Film muss 
zudem die Perforation nach vorn zeigen.  Vertonter 35mm-Film muss so eingelegt werden, 
dass die Tonspur hinten liegt.  
Die daraus resultierende Wickelrichtung des Films ist zunächst unwesentlich. Ebenso ein 
eventuell spiegelverkehrtes Bild auf dem Monitor. Dieses können Sie später mithilfe der 
Mirror -Funktion [S. 33] korrigieren. 

Achtung! 
Fahren Sie vor dem Einlegen die Kamera möglichst weit nach oben (Zoom auf Minimum 
stellen [S. 29], um Beschädigungen der Optik zu vermeiden. 

Bei der Umschlingung beweglicher Rollen ist es nicht erforderlich, eine bestimmte Straffheit 
zu erzeugen. Diese regelt das Gerät später selbst. 

6.1.1.3 Filmformat  einrichten  

Anschließend stellen Sie den Perforations-Sensor (Nr. 4 in Abbildung 1 [S.14]) auf den aktuel-
len Filmtyp ein: 

a) für „35mm“ drücken Sie den Sensor ganz nach hinten. 

b) für „16mm“ ziehen Sie den Sensor ganz nach vorn. 

 

 

35mm 

 

16mm 

Abbildung 5: Einstellungen am Perforations-Sensor 

Dadurch wird der Laserstrahl, der für die Erkennung der Perforation verantwortlich ist, me-
chanisch entsprechend den Abmessungen der Filmformate ausgerichtet. 

Prüfen Sie, ob der Laserstrahl über die Mitte der Perforationslöcher läuft.  

6.1.1.4 Ton aktivieren  

Je nach Ausstattung des Gerätes können Sie zusätzlich 35mm-Lichtton oder 16mm-Licht- und 
Magnetton übertragen. Aktivieren Sie hierfür nach dem Einlegen des Films den entsprechen-
den Tonkopf rechts vom Lampenhaus, indem Sie ihn bis zum Anschlag nach vorn herauszie-
hen (siehe Abbildung 6 [S.22]). 

Die Lage des Tonkopfes quer zur Filmlaufrichtung können Sie mithilfe der Stellschraube S 
justieren. Der Film muss exakt mittig auf den Führungsrollen liegen. 
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Abbildung 6: Aktivierung Tonkopf Abbildung 7: Führungsrollen am Tonkopf 

 

 

Technisch bedingt ist es erforderlich, dass die Führungsrollen des Tonkopfes auf dem Film 
aufliegen. Dadurch kommt es bei häufigen Filmbewegungen unvermeidlich zu mechani-
schen Belastungen des Filmmaterials. 

Vermeiden Sie daher jede unnötige Filmbewegung bei aktiviertem Tonkopf, insbesondere 
ein schnelles Spulen. 

Aktivieren Sie den Tonkopf möglichst erst unmittelbar vor Beginn des Scans! 
Achten Sie außerdem besonders darauf, dass die Führungsrollen sauber und staubfrei sind! 

 

6.1.1.5 Run-Zustand herstellen  

Nach dem Einlegen des Films und der eventuellen Aktivierung des Tonkopfes müssen an der 
Bediensoftware zwei Einstellungen vorgenommen werden: 

1. Angabe der aktuellen Wickelrichtungen 

Klicken Sie hierzu jeweils auf die Abbildung der Quell- und der Ziel-Spule, bis die darge-
stellte Grafik dem tatsächlichen Filmlauf am Gerät entspricht. 

Alternativ dazu können Sie auch den Load-Stop-Schalter, der der jeweiligen Spule zuge-
ordnet ist, etwas länger als 1 Sekunde gedrückt halten (siehe Abbildung 1 [S.14]). Damit 
wird ebenfalls intern die Wickelrichtung geändert. 
Das Gerät zeigt die neue Wickelrichtung dies durch ein langsames Drehen der Spule an. 

 

Abbildung 8: Filmlauf-Beispiel 
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2. Angabe des Filmformats 

Klicken Sie im linken Bereich des Fensters auf das Filmformat, das dem am Gerät einge-
legten Film bzw. der Stellung des Perforations-Sensors entspricht. 

 

Abbildung 9: Filmformatauswahl  

Hinweis: 

Mit der Auswahl des Filmformats können Sie bestimmte Voreinstellungen verknüpfen, die 
dann automatisch eingestellt werden. Weitere Informationen finden Sie unter 6.3.2 
αSpeichern und Laden von Einstellungenά [S.45]. 

Der varioHD und die Bediensoftware sind damit fertig eingerichtet.  

Um den Film scannen zu können, wechseln Sie nun in den Run-Zustand, indem Sie auf 
 klicken oder beide Load-Stop-Schalter am Gerät gleichzeitig kurz gedrückt halten. 

Jetzt zieht der varioHD den Film straff und überprüft, ob alle Teile des Filmlaufs einwandfrei 
eingerichtet sind. Anschließend wechselt die Bediensoftware in die Abteilung „Run“. 

Sollte der Film nicht straff gezogen werden oder nach kurzer Zeit nicht zum Stillstand kom-
men, dann stoppen Sie den Vorgang durch Drücken eines der beiden Load-Stop-Schalter am 
Gerät und überprüfen Sie folgende Punkte: 

- Stimmt die tatsächliche Wickelrichtung überein mit den Einstellungen, die Sie in der 
Bediensoftware vorgenommen haben? (siehe Abbildung 8 [S.22]) 

- Ist der Film exakt eingelegt? 
Dies gilt neben dem richtigen Filmlauf insbesondere für die Bereiche am Perforations-
Sensor, an der Scan-Einheit und ggf. am Tonkopf. Dort sollte der Film einwandfrei 
durchlaufen und überall glatt anliegen, gerade und plan laufen. 

- Stimmt die Stellung des Perforations-Sensors mit der Auswahl des Filmtyps in der Be-
diensoftware überein? (siehe Abbildung 9) 

Alle nun folgenden Schritte entnehmen Sie Abschnitt 6.2 „Scanning“ [S.27]. 

Durch Klicken auf  oder Drücken auf einen der Load-Stop-Schalter können Sie jeder-
zeit noch einmal vom Run- zum Load-Zustand (Einlegen des Films) zurückwechseln. 
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Ein/Aus

Load

Run

Play

Shuttle

Step

Alle Motoren aus

Film einlegen

"Run" anklicken

oder am Gerät

beide Load-Stop-Schalter drücken

Film gespannt und abspielbereit

Film läuft

"Load" anklicken

oder am Gerät

einen Load-Stop-Schalter drücken

Alle Motoren aus

Film auslegen

"Stop" anklicken

Film hält an

Film noch gespannt

 

Abbildung 10: Bedienreihenfolge 

Hinweis: 
5ŜǊ «ōŜǊƎŀƴƎ Ǿƻƴ αwǳƴά Ȋǳ α[ƻŀŘά ǳƴŘ ǳƳƎŜƪŜƘǊǘ ōŜŜƛƴŦƭǳǎǎǘ nicht den Bildzähler, solange 
der Film an der Capstan-Rolle (rechts vom Filmgate) fest anliegt und dort seine Lage nicht 
verändert. Lediglich ein Abbruch durch Drücken eines der Load-Stop-Schalter oder durch das 
Gerät selbst bei einem akuten Transportproblem trennt den internen Zähler vom tatsächli-
chen Filmlauf. In diesem Fall muss die Startposition ό.ƛƭŘ αлάύ ƴŜǳ ŦŜǎǘƎŜƭŜƎǘ ǿŜǊŘŜƴΦ  

6.1.1.6 Weitere Einstellungen  

a) Tension 

Bei besonders empfindlichem Filmmaterial kann es erforderlich sein, die Zugkraft, mit 
der der Film transportiert wird, zu reduzieren, um ein Reißen oder andere Beschädi-
gungen zu vermeiden. 

Mit der Option „Tension“ können Sie diesen Wert steuern (Abbildung 11). 

 

Abbildung 11: Tension 

Für jeden der beiden Betriebszustände „Run“ (Scanning) und „Wind“ (Spulen) besteht 
die Möglichkeit, einen eigenen Wert festzulegen. 

b) Perforation Detection 

Der varioHD bestimmt die Bildlage anhand der Position der Perforationslöcher mithil-
fe eines Laser-Sensors. Bei extrem klaren Filmen kann es erforderlich sein, die Emp-
findlichkeit der Erkennung zu erhöhen, weil der Unterschied der Lichtdurchlässigkeit 
zwischen Filmmaterial und Perforationsloch sehr gering ist. Für diesen Fall verschie-
ben Sie den Regler in Richtung „Sensitive“. 
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Diese Einstellung macht den Sensor so empfindlich, dass bereits Schwankungen des 
Umgebungslichtes die Erkennung von Perforationslöchern beeinflussen und stören 
können. Dunkeln Sie nach Möglichkeit den Raum ab. 

Bei Filmen mit hohem Schwärzungsanteil kann der Regler in Richtung „Accurate“ 
verschoben werden. Dadurch wird auch der Einfluss des Umgebungslichtes gemin-
dert. 

Für die Mehrzahl der Filme ist ein mittlerer Wert ausreichend. 

 

Abbildung 12: Perforation Detection 

c) Filmgate fan 

Hiermit können Sie die Belüftung der Lichtquelle während des Scannings ein- bzw. 
ausschalten. Dies ist eine zusätzliche Funktion, um Staub zu beseitigen, der sich ober-
flächlich auf dem Glas der Beleuchtungseinheit oder im Raum befindet. 

6.1.2 Film auslegen 

Vor dem Auslegen des Films sollte der Tonkopf deaktiviert, also in die Parkposition nach hin-
ten verschoben werden. Die Führungsrollen am Tonkopf liegen sehr dicht am Film an und 
könnten bei unvorsichtigem Hantieren zu Beschädigungen am Filmmaterial führen. 

Um den Film auszulegen drücken Sie einen der Load-Stop-Schalter oder klicken Sie in der 

Bediensoftware auf . Daraufhin lockert sich der Film wieder und kann komplett aus 
der Filmführung entnommen werden. 

Der Übergang von Run zu Load (Load-Stop-Schalter oder über die flashsuite) hat zunächst 
keine Auswirkungen auf den internen Bildzähler. Dieser ist allerdings u.a. an den Capstan ge-
koppelt (Nr. 10 in Abbildung 1 [S.14]). Verschiebt sich in der Film während des Stopps auf die-
ser Rolle, dann führt das zu einer Ungenauigkeit bei der Zählung der Filmbilder. 

6.1.3 Film spulen 

Der Film kann im geladenen Zustand jederzeit mit bis zu 300 Bildern pro Sekunde (bei 16mm-
Film bis zu 800 fps) vorwärts oder rückwärts gefahren werden (vgl. „Filmtransport“ [S.28]). 

Um jedoch z.B. nach Abschluss des Scannings einen kompletten Film schnell umzuspulen, 
nutzen Sie besser die hierfür vorgesehene Funktion „Wind“ (siehe Abbildung 14 [S.26]). 
Dies gewährleistet eine deutlich geringere mechanische Belastung des Filmmaterials. 

Sollte sich der varioHD noch im Run-Zustand befinden (Film gespannt), dann lösen Sie die 
Filmspannung durch Betätigung eines der Load-Stop-Schalter[S. 14]. 

Anschließend legen Sie den Film wie folgt ein: 
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Abbildung 13: Filmlauf für Umspulen 

Die Richtung, in der der Film an den beiden Filmspulen aufliegt, ist zunächst gleichgültig. 

Teilen Sie anschließend der Bediensoftware durch Klicken auf die abgebildeten Filmspulen die 
tatsächliche Wickelrichtung mit. Klicken Sie hierzu jeweils auf die Abbildung der Quell- und 
der Ziel-Spule, bis die dargestellte Grafik dem tatsächlichen Filmlauf am Gerät entspricht. 

Aktivieren Sie danach durch Klicken auf den Button  die Umspulfunktion. 

Mit den darunter befindlichen Schaltern können Sie die Richtung und Geschwindigkeit des 
Umspulens festlegen sowie den Vorgang stoppen. 

 

Abbildung 14: Wind-Steuerung 

Dabei bewirkt ein Klick auf die Buttons  bzw.  das Umspulen mit höchst-
möglicher Geschwindigkeit. Für empfindlicheres Filmmaterial sollte dagegen der Schiebereg-
ler zur Einstellung eines geringeren Umspultempos verwendet werden. 
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6.2 Scanning 

Nach dem Einlegen des Films und Übergang in den Run-Zustand erscheint auf dem Bildschirm 
die Oberfläche (GUI) der flashsuite für das eigentliche Scanning: 

 

Abbildung 15: Startbildschirm Run-Zustand 

Der Bildschirm teilt sich in folgende Bereiche: 

Oberes Drittel: „Color Correction“ Farbkorrektur-Einstellungen 

Mitte links: „Geometry“ Zoom, Schärfe, Bildlage 

Unten links: „Erweiterte Einstellungen“ Ton, Bildverarbeitung, Geometrie 

Mitte: „Transport“ Film-Bewegung, Geschwindigkeit 

Unten rechts: „Cue points“ Liste für szenenweise Einstellungen 

Alle zur Vorbereitung erforderlichen Schritte werden auf den folgenden Seiten detailliert 
beschrieben. Sind diese Arbeiten abgeschlossen, dann beginnen Sie das eigentliche Scanning. 
Gehen Sie dabei wie folgt vor: 

1. Starten Sie den an den varioHD angeschlossenen Videorecorder bzw. Ihre Video-
Aufzeichnungs-Software. 

2. Starten danach Sie die Wiedergabe am varioHD mit dem Schalter  oder der 
Leertaste. 

3. Nach Abschluss des Scannings stoppen Sie zuerst die Aufzeichnung am Videorecor-
der, danach halten Sie den Film durch Klick auf  an. 
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6.2.1 Filmtransport und Positionierung 

Wählen Sie eine geeignete Filmgeschwindigkeit über die Speed-Liste aus. Die Angaben erfol-
gen in Bildern pro Sekunde (fps). 

 

Abbildung 16: Film-Speed 

Dies kann durch Öffnen der Liste, über die Schalter [+] und [–] links und rechts daneben oder 
über die + und – Taste am Nummernblock der Computer-Tastatur erfolgen. 
Als Geschwindigkeiten stehen verschiedene Stufen zwischen 4,1666 und 800 fps (für 35mm-
Film maximal 300 fps) zur Verfügung. 

 

Achtung! Sollte eine Geschwindigkeit mit einem Stern (*) gekennzeichnet sein, dann kann 
diese nur zu Vorschauzwecken (Preview), jedoch nicht für das eigentliche Scanning ver-
wendet werden! 

 

Mit den Schaltern  können Sie nun den Film in der ausgewählten Ge-
schwindigkeit vorwärts und rückwärts bewegen oder in Einzelbild-Schritten transportieren. 

Der Schalter  stoppt die Bewegung. 

Hinweis: 
Ein Wechsel zwischen Play- und Stopp-Zustand ist auch mit Hilfe der Leertaste möglich. 

Um den Film schnellerer zu transportieren nutzen Sie den Shuttle-Regler, der sich unterhalb 
der Geschwindigkeits-Auswahl befindet. 

Bewegen Sie den Film anschließend auf das erste Bild oder eine geeignete Startmarkierung 
und klicken Sie auf den Button „0“ neben dem Bildzähler. Damit wird dieser auf Null gesetzt. 

Zu dieser und jeder anderen Bildposition können Sie gezielt fahren, indem Sie im Feld unter-
halb des Bildzählers die Nummer des gewünschten Bildes eingeben und auf den Button „Cue“ 
klicken. 

 

Abbildung 17: Bildposition anfahren 

Die Bestimmung eines definierten Filmanfangs ist nicht nur wichtig für ein bequemes Positio-
nieren des Films während der Arbeit (inklusive Zurückspulen an den Anfang) sondern auch 
unabdingbare Voraussetzung für szenenweise Korrekturen (siehe Abschnitt 6.2.6.1 [S.41]) 
ŜǾŜƴǘǳŜƭƭŜ aŜǎǎǳƴƎŜƴ όǎƛŜƘŜ αMeta-Datenά [S.47])! 
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6.2.2 Bildformat festlegen 

Die Festlegung des zu scannenden Bildausschnitts erfolgt in zwei Schritten: 
Vertikale Begrenzung durch Zoom und Bildstrich (Frameline) sowie horizontale Begrenzung 
durch Bildformat, Bildlage und Kaschierung. Diese werden im Folgenden erläutert. 

Berücksichtigen Sie bei der Wahl des Ausschnitts auch, dass durch Bildstandsschwankungen 
die Lage der nachfolgenden Bilder verändert sein kann und dadurch ggf. deren Bildbegren-
zungen oder Teile der Perforation im Ausschnitt sichtbar werden. Lassen Sie daher nach Fest-
legung des Bildausschnitts den Film kurz laufen, um sicher zu stellen, dass alle Bilder in der 
gewünschten Weise dargestellt werden. 

Suchen Sie für den nächsten Schritt nun ein Bild, bei dem die äußeren Ränder gut zu erken-
nen sind, um den Bildausschnitt festlegen zu können. 

6.2.2.1 Obere und untere Bildbegrenzung , Zoom und Schärfe 

Die obere und untere Grenze des Bildausschnitts wird durch den Zoomfaktor und die Positio-
nierung des Bildstrichs festgelegt. 

Verwenden Sie hierfür die Einstellmöglichkeiten im Bereich „Geometry“: 

 

Abbildung 18: Einstellung der Bildgeometrie 

Im ersten Schritt sollte der Zoom (die Bildvergrößerung und damit der sichtbare Ausschnitt) 
festgelegt werden. Schieben Sie den entsprechenden Zoom-Regler solange nach rechts oder 
links, bis der gewünschte Bildausschnitt zunächst grob eingerichtet ist – die Feinjustage er-
folgt im Anschluss. Die Zoom-Veränderung ändert die Position der Kamera zur Filmebene und 
hat zur Folge, dass die bisher eingestellte Schärfe korrigiert werden muss. Dies erfolgt mit 
dem darunter befindlichen Regler „Focus“. Ändern Sie dessen Lage soweit, bis die Abbildung 
auf dem Referenzmonitor erstmals scharf ist. 

Sollte das Bild in senkrechter (Filmlauf-)Richtung verschoben sein, dann korrigieren Sie dies 
mit dem „Frameline“-Regler nach oben oder unten. Ein Klick auf die Buttons „+“ oder „–“ 
bewirkt einen Sprung des Bildes um einen Perforationsloch-Abstand nach oben oder unten. 

Liegt das Bild in horizontaler Richtung verschoben, dann können Sie die Bildlage über den 
„Pan“-Regler korrigieren. 

Dieser Vorgang wird solange wiederholt, bis die gewünschte obere und untere Grenze sowie 
die horizontale Lage für den Bildausschnitt gefunden ist. 

Danach sollte noch einmal die Schärfe präzise eingestellt werden. Hierfür steht Ihnen der 
Focusindicator zur Verfügung. Je länger der angezeigte Balken ist, umso besser ist die Schär-
fe. Sollte sich der Balken in der Nähe des Maximums bewegen, dann stellen Sie ihn mit einem 
Klick auf den Schalter „Fit“ wieder auf einen mittleren Wert zurück, damit er weiteren Spiel-
raum erhält. Die bis dahin eingestellte Schärfe wird dadurch nicht beeinflusst! 

Wenn der Bildinhalt nicht genügend Anhaltspunkte für die Einstellung der Schärfe liefert, 
dann verwenden Sie den Schalter „EZ Focus“ (sprich: „Easy-Focus“). Ist dieser aktiviert, dann 
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werden in dem Moment, in dem sie mit der Maus den „Focus“-Regler bedienen, alle im Bild 
vorhandenen Details (Körnung, Kanten usw.) kurzzeitig extrem angehoben. Damit lässt sich 
der Punkt maximaler Schärfe in der Regel sehr leicht finden. Die Schärfeanhebung gilt nur, 
solange Sie den Focus-Regler bedienen.  

Hinweis: 
Alle Schieberegler können auch über die Tastatur bedient werden. Das ermöglicht oftmals 
eine deutlich präzisere Einstellung der entsprechenden Werte. 
Hierzu muss der betreffende Regler zunächst mit einem Mausklick ausgewählt (aktiviert) wer-
den. Anschließend ist über die Pfeiltasten auf Ihrer Tastatur eine Verschiebung des Reglers in 
sehr feinen Einzelschritten möglich. 

Zusätzlich können Sie zwischen einzelnen Elementen des Bildschirms auch mit der Tabulator-
Taste (TAB bzw. Shift-TAB) wechseln. 

Zusatzfunktion „Focus LUT“ 

Die stets erforderliche Nachführung der Schärfe bei einer Veränderung des Zooms kann au-
tomatisiert werden, so dass es fortan genügt, nur einen Wert für Zoom einzustellen. Die dazu 
gehörige Schärfe regelt der varioHD anschließend von selbst. 

Hierzu muss eine so genannte Focus-LUT eingerichtet werden. Dies ist eine Übersetzungsta-
belle, die jeder Zoom-Position der Kamera einen entsprechenden Schärfepunkt zuordnet. 

Für die Einrichtung der Focus-LUT steht Ihnen der Menüpunkt „View -> Focus LUT“ zur Ver-
fügung. Im daraufhin sich öffnenden Fenster sehen Sie eine Diagramm-Oberfläche, die hori-
zontal den Wertebereich aller Zoom-Positionen und vertikal den gesamten Focus-Umfang 
darstellt (Abbildung 19). 

 

Abbildung 19: Focus LUT 

Im Ausgangszustand ist das Diagramm zunächst leer. Gehen Sie nun wie folgt vor 
(während aller Bedienvorgänge kann das Focus-LUT-Fenster geöffnet bleiben): 

1. Deaktivieren Sie die Option „Use Focus LUT“, um unerwünschte Nebeneffekte durch 
vorherige Einstellungen zu unterbinden. 

2. Fahren Sie den Zoom-Regler auf Position 0. 
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3. Stellen Sie – unabhängig vom sichtbaren Bildausschnitt – eine optimale Schärfe ein. 

4. Klicken Sie danach auf „Add Focus Point“ im Focus-LUT-Fenster, um einen Punkt der 
Kurve zu generieren. 

5. Fahren Sie anschließend den Zoom zu einem etwas höheren Wert. 

6. Wiederholen sie die Schrittfolge bei Punkt 3 bis alle gewünschten Zoom-Positionen 
durchlaufen sind. 

Im unteren Bereich der Zoom-Werte sollte die Schrittweite sehr klein gewählt werden, um eine 
möglichst dichte Kurve zu generieren. Bei höheren Zoom-Werten sind größere Schrittweiten 
möglich, weil die resultierende Kurve nur noch einen sehr geringen Anstieg hat. 

Sie können jeden erzeugten Kurvenpunkt durch Mausklick anfahren und kontrollieren. 

Versehentlich falsch gesetzte Punkte müssen zunächst gelöscht und anschließend neu er-
zeugt werden. Eine grafische Verschiebung ist nicht möglich. Wechseln Sie für diesen Fall von 
„Graphical view“ zu „LUT Points“. Markieren Sie das entsprechende Werte-Paar mit der 
rechten Maustaste und wählen Sie „Delete“ (Abbildung 20). Erzeugen Sie anschließend einen 
neuen Punkt wie oben beschrieben. 

Am Ende des Prozesses sollte eine Kurve ähnlich der in Abbildung 19 [S.30] entstanden sein. 
Über den Menüpunkt „LUT -> Save“ (im Diagramm-Fenster) muss diese gespeichert werden. 
Es wird nur eine einzige LUT-Datei abgelegt. Sie können daher keinen Dateinamen vergeben. 
Über „LUT -> Open“ können Sie die gespeicherte LUT jederzeit wieder aktivieren. 

Zuletzt aktivieren Sie die Option „Use Focus LUT“, womit die automatische Nachführung der 
Schärfe entsprechend einer gewählten Zoom-Position eingeschaltet ist.  

 

Abbildung 20: Focus LUT Korrektur 
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6.2.2.2 Ausgabeformat festlegen  (Outpu t Processing) 

Wechseln Sie links unten auf dem Bildschirm in den Bereich „Output Processing“. 

Wichtig! 
Alle im Folgenden beschriebenen Output-Processing-Einstellungen werden nur an den Aus-
gängen (HD)SDI 1 und 2 wirksam (siehe Abbildung 2 [S.15]). Die Ausgänge (HD)SDI 3 und 4 
geben stets das unbearbeitete Videosignal der Scanner-Kamera wieder. 

 

Abbildung 21: Output-Processing 

Zunächst sollte festgelegt werden, in welchem Videoformat die Bildausgabe erfolgen soll. 
Folgende Auswahlmöglichkeiten stehen zur Verfügung: 

- SD 4:3 Ausgabeformat 720x576 Pixel (SD) 

- SD 16:9 Ausgabeformat 720x576 Pixel (SD) 
wobei durch anamorphotische Stauchung in horizontaler Richtung deut-
lich mehr Bildinhalt erfasst werden kann 
Dieses Format ist insbesondere geeignet für eine 16:9-Fernseh-
Wiedergabe, wenn die Bildbreite eingepasst werden soll (andernfalls soll-
te für diese Wiedergabeform das 4:3-Format gewählt werden) 

- 720p50 Ausgabeformat 1.280x720 Pixel (HD, progressive) 

- 1080i50 Ausgabeformat 1.920x1.080 Pixel (HD, interlaced)  

- 1080p25 Ausgabeformat 1.920x1.080 Pixel (HD, progressive) 

Weiterhin können Sie festlegen (siehe Abbildung 21): 

- Black and White 
Ausgabe in reinem Schwarz-Weiß-Format 
Diese Einstellung ist bei Schwarz-Weiß-Filmen sinnvoll, die aufgrund des Filmmateri-
als oder Lagerungsprozessen Verfärbungen enthalten. 

Tipp zum Scannen von Schwarz-Weiß-Material: 
Der "Black and White" Schalter entfernt sämtliche Farbinformationen aus 
dem Bildsignal, damit das Bild vollkommen ohne Farbstich gescannt wird. Es 
passiert jedoch gelegentlich, dass Schwarz-Weiß-Material und Farbmaterial 
auf einer Rolle gemischt sind. Wenn Sie im Schwarz-Weiß-Modus scannen, 
bemerken Sie diesen Wechsel möglicherweise nicht. Die SDI-Ausgänge 3 und 4 
tragen immer alle Farbinformationen. Betrachten Sie das Bild über einen die-
ser Ausgänge, dann können Sie erkennen, wenn wieder Farbmaterial gescannt 
wird. 
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- Anamorph 
Ausgabe um den Faktor 2:1 in horizontaler Richtung dehnen. 
Verwenden Sie diese Option, um Bilder, die bereits anamorphotisch (also horizontal 
gestaucht) aufgenommen worden sind, zu entzerren. 

- Mirror  
Spiegelung in horizontaler Richtung. Dies ermöglicht u.a. das Scanning eines Films, 
der seitenverkehrt eingelegt wurde, ohne diesen erneut wechseln zu müssen. 

- Negative 
Bei Aktivierung dieser Option werden Helligkeit und Farbe des Bildes auf allen Aus-
gängen des varioHD invertiert, um das Scannen von Negativmaterial zu erleichtern. 
Die Farbkreise der primären Farbkorrektur [S. 34] wirken farbrichtig. Das bedeutet, 
dass die tatsächliche Farbe der Lichtquelle genau invertiert ist gegen die Farbe auf 
dem Farbkreis. Beachten Sie, dass die Light-Einstellungen nun auf die dunklen Berei-
che im Bild wirken, während die Black-Einstellungen auf die hellen Bereiche des Bil-
des wirken.  

Tipps zum Negativ-Scannen 

· Abhängig vom Filmmaterial und dessen Belichtung kann es beim Negativ-
Scannen nötig sein, das Video-Dŀƛƴ ƛƴ α!ŘǾŀƴŎŜŘ LƳŀƎŜ {ŜǘǘƛƴƎǎά [S. 38] an-
zuheben und den White-Clip-Wert etwas abzusenken.  

· Um die Orangemaske des Trägermaterials zu kompensieren eignet sich sehr 
gut die Auto-Light-Funktion [S. 36]. 

· Sie können die unter αAdvanced Image Settingsά ǾƻǊƎŜƴƻƳƳŜƴŜƴ 9ƛƴǎǘŜl-
lungen als automatische Vorgabe einrichten, die immer dann aktiviert wird, 
ǿŜƴƴ {ƛŜ ƛƴ αhǳǘǇǳǘ {ŜǘǘƛƴƎǎά ŘƛŜ hǇǘƛƻƴ αbŜƎŀǘƛǾeά ŀǳǎǿŅƘƭŜƴΦ 
Weitere Informationen finden Sie unter 6.3.2 αSpeichern und Laden von Ein-
stellungenά [S.45]. 

Besonderheiten bei Interlaced Formaten 

Interlaced-Video besteht aus Halbbildern, die nur jede zweite Zeile der vollen Bildauflösung 
enthalten. Je zwei dieser Halbbilder („Fields“) ergeben ein Vollbild („Frame“). 

Wenn Sie in einem Interlaced-Format arbeiten, dann erstreckt sich ein Bild auf dem Film über 
zwei Halbbilder im resultierenden Video.  

Bei niedrigeren Scan-Geschwindigkeiten müssen Filmbilder wiederholt werden, da die Video-
Aufzeichnungsrate mit 25fps fest vorgegeben ist. Dabei ergeben sich unterschiedliche Mög-
lichkeiten der Bildwiederholung, die sie in „Options -> Preferences -> Interlacing Settings“ 
konfigurieren können [S. 51]. 

Höhere Transportgeschwindigkeiten stehen nur für die Vo rschau zur Verfügung. Diese 
sind mit einem Stern (*) hinter der Geschwindigkeitsangabe kenntlich gemacht. 

6.2.2.3 Bildau sschnitt einstellen  

Zuletzt ist die physische Begrenzung des Bildausschnitts in horizontaler Richtung festzulegen. 
Verschieben Sie hierfür im dargestellten schwarzen Bildfeld die grünen Begrenzungslinien 
(Kaschierung) soweit, bis der gewünschte Ausschnitt erreicht ist (siehe Abbildung 21 [S.32]). 

Beachten Sie dabei, dass der resultierende Bildinhalt automatisch stets in die Mitte des aus-
gegebenen Videobildes gesetzt wird. 
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Sie können auch hier eine präzisere Auswahl treffen, wenn Sie zunächst eine der Begren-
zungslinien nur anklicken und anschließend mit den Pfeiltasten Ihrer Tastatur positionieren. 

6.2.3 Farbwerte einstellen 

Zur Einstellung und Korrektur der Farbwerte steht der Bereich im oberen Drittel des Bild-
schirms zur Verfügung.  

Dieser enthält zwei Teile, die durch Reiter am oberen Rand erreichbar sind: 

- Primary Color Correction: Alle hier vorgenommenen Einstellungen beeinflussen di-
rekt das Verhalten der Kamera und der Lichtquelle des varioHD. 

- Secondary Color Correction: Diese ändert nur die Chroma-Kanäle und legt die Form 
des Farbraums fest. Schwarz-Weiß-Bilder werden durch diese Korrektur-Funktion 
nicht verändert. 

6.2.3.1 Primäre Farbkorrektur  

 

Abbildung 22: Primäre Farbkorrektur 

Hier finden Sie im linken Teil drei Farbkreise, zu denen jeweils rechts daneben ein Schiebereg-
ler gehört. Mit den Reglern werden die Korrekturwerte Black, Gamma und Light eingestellt. 

Das Markierungskreuz innerhalb der Farbkreise steht normalerweise im Zentrum. Damit wirkt 
der Regelwert gleichmäßig auf alle Farb- und Helligkeitsanteile im Bild. Wird die Kreuzmarkie-
rung jedoch in Richtung des Kreisrandes auf eine bestimmte Farbe verschoben, dann wirkt 
sich die Korrektur mehr oder weniger stark auf diesen Farb- bzw. Helligkeitsanteil des Bildes 
aus. 

Die drei Korrekturwerte haben folgenden Einfluss auf das Filmbild: 

1. Black 

Verändert den Schwarzwert und damit Helligkeit in allen Bildbereichen. 

 

Abbildung 23: Black-Level-Funktion 
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Ein positiver Black-Level erhöht die Helligkeit über das gesamte Bild – es wird weißer. 
Helle Bildbereiche verlieren dadurch aber zunehmend an Zeichnung (sie „klippen“ 
oder „brennen aus“). Umgekehrt lässt ein negativer Black-Level das Bild dunkler er-
scheinen. Hierdurch verlieren aber dunkle Bildbereiche an Struktur. 

2. Gamma 

Veränderung der mittleren und dunklen Bildbereiche ohne maßgebliche Beeinflus-
sung der hellen und ohne Änderung des Schwarz- und des Weißpunktes. 

 

Abbildung 24: Gamma-Funktion 

Durch Anheben des Gamma-Wertes werden die dunklen Bildbereiche aufgehellt. 
Dadurch ist es möglich, dort vorhandene, aber evtl. nicht gut sichtbare Strukturen 
deutlicher hervortreten zu lassen. Ein Absenken des Gamma-Wertes führt zu einer 
Schwärzung der dunklen Bildbereiche. Dies ist dann erforderlich, wenn das Bild im 
Ganzen zu hell ist (wie z.B. bei überbelichteten Filmen) und kräftiger erscheinen soll. 

3. Light 

 

Abbildung 25: Light-Funktion 

Die Veränderung des Light-Wertes hat direkten Einfluss auf die Lichtstärke der Be-
leuchtungseinheit und bewirkt, dass das Bild im Ganzen heller oder dunkler er-
scheint. Im Gegensatz zum Black-Level bewirkt aber ein höherer Light-Wert kein An-
heben der schwarzen Bildelemente – das Bild wirkt nicht „weißlich“. Zu hohe Light-
Einstellungen führen aber wiederum zu einem sichtbaren Verlust an Struktur in den 
hellen Bereichen (sie „klippen“ oder „brennen aus“). 
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Im rechten Bereich befindet sich ein Histogramm („Auto Light“), das die Verteilung der Hel-
ligkeiten für die Kanäle Rot, Grün und Blau darstellt. 

Durch einen Rechtsklick auf dieses Diagramm können Sie dessen Darstellungsform ändern: 

 

Abbildung 26: Histogramm einstellen 

Für die meisten Anwendungen ist die Form „Cascade“ (die getrennte Darstellung der Farbka-
näle) optimal. 

Die Auto-Light-Regelung bietet drei Einstellungen, die Sie durch Klicken auf den jeweiligen 
Button rechts aktivieren: 

1. Brightness 

Über diesen Modus können Sie die Helligkeit aller Farbkanäle vom Gerät automatisch 
optimieren lassen. 

Diese Funktion ist hilfreich, wenn im Film häufige Helligkeitsschwankungen auftreten, 
deren manuelle Korrektur zu aufwändig wäre. 

Die im Histogramm sichtbare weiße Begrenzungslinie kennzeichnet die maximal zuläs-
sige Helligkeit, die während der automatischen Optimierung nicht überschritten wird. 
Sie kann mit der Maus verschoben werden. 

Ist dieser Modus aktiviert, dann können Sie keine Einstellungen des Light-Wertes vor-
nehmen (siehe Abbildung 22 [S.34]). 

2. Color 

Mit diesem Modus werden die Farbwerte der Filmbilder automatisch optimiert. Dabei 
wird intern ein mittlerer Bereich jedes Bildes analysiert und farblich so angepasst, dass 
der Gesamteindruck weitestgehend neutral ist, ohne den Grundcharakter zu verän-
dern. 

Im Histogramm finden Sie für jeden Farbkanal eine Begrenzungslinie, die den Maxi-
malwert des entsprechenden Farbwertes festlegt, der während der automatischen Op-
timierung nicht überschritten wird. Diese Linien können Sie mit der Maus verschieben 
und somit einen farblichen Grundcharakter festlegen. 

Ist dieser Modus aktiviert, dann können Sie keine Einstellungen des Light-Wertes vor-
nehmen (siehe Abbildung 22 [S.34]). 

3. Off 

Bei abgeschalteter Auto-Light-Regelung ist es möglich, jeden Farbkanal manuell zu be-
einflussen. Alle hier vorgenommenen Einstellungen bleiben während des Scanprozes-
ses konstant. Dies entspricht einem so genannten „Einlicht-Scanning“. 
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Abbildung 27: Manuelle Korrektur im Histogramm (Auto light) 

Setzen Sie die Maus in das Diagramm des zu verändern Farbkanals und ziehen Sie an-
schließend mit gedrückter Maustaste nach links, um das Licht (Gain) des Farbkanals zu 
reduzieren oder nach rechts, um ihn zu verstärken. Die Mausbewegung wird mit einer 
hellen Fläche angezeigt (in der Abbildung erkennbar für den Grün-Kanal). 
Veränderungen, die in diesen Histogrammen vorgenommen werden, entsprechen den 
Einstellungen, die mit der Funktion „Light“ [S. 35] in der primären Farbkorrektur mög-
lich sind. 

Hinweis: 

Wenn die von Ihnen vorgenommenen Veränderung zu keinem wünschenswerten Resul-
tat führen, dann kann es hilfreich sein, zunächst vom Programm eine automatische Op-
timierung ǸōŜǊ ŘƛŜ CǳƴƪǘƛƻƴŜƴ α.ǊƛƎƘǘƴŜǎǎά ƻŘŜǊ α/ƻƭƻǊά ǾƻǊƴŜƘƳŜƴ Ȋǳ ƭŀǎǎŜƴΣ ŀn-
ǎŎƘƭƛŜǖŜƴŘ ȊǳƳ aƻŘǳǎ αhŦŦά ȊǳǊǸŎƪȊǳƪŜƘǊŜƴΣ ǳƳ ƎƎŦΦ ǿŜƛǘŜǊŜ YƻǊǊŜƪǘǳǊŜƴ Ǿƻƴ Iŀnd 
vorzunehmen. 

 

Für die automatisierten Modi „Brightness“ und „Color“ steht Ihnen zusätzlich noch der Regler 
„Headroom“ zur Verfügung. Dieser legt die Toleranz fest, mit der die Farb- oder Helligkeits-
werte an den von Ihnen gesetzten Begrenzungslinien gehandhabt werden. 

Ist „Headroom“ ganz nach unten verschoben, dann wird die Toleranz auf 0% festgelegt, so 
dass kein Pixelwert die Begrenzungslinie überschreitet. Bei oberem Anschlag des Reglers ge-
hen 10% der Pixelwerte über die Begrenzungslinie hinaus. Dadurch erscheint das Bild etwas 
heller oder farbiger und reagiert zugleich unempfindlicher auf Spitzlichter. 

6.2.3.2 Sekundäre Farbkorrektur  

 

Abbildung 28: Secondary Color Correction 

Im Gegensatz zur Primären Farbkorrektur, die sich auf das gesamte Bild gleichmäßig auswirkt, 
nimmt die sekundäre Farbkorrektur Einfluss auf einzelne Farben im Bild. Der Farbton und die 
Sättigung der einzelnen Farbbereiche kann verändert werden, ohne den Rest des Bildes zu 
beeinflussen. 

Sie können damit beispielsweise die Sättigung der Rottöne im Bild verändern, ohne den rest-
lichen Bildinhalt zu verändern. 
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Für die Farbwerte Rot, Grün und Blau bzw. Cyan, Magenta und Gelb stehen Ihnen jeweils 
zwei Regler zur Verfügung, die den Farbwert („Hue“) und dessen Sättigung („Saturation“) 
verändern. 

Mit dem Regler „Master“ wird die Gesamtsättigung des Bildes geregelt. 

6.2.4 Weitere Bildeinstellungen vornehmen (Advanced Image Settings) 

Im unteren Teil des Bildschirms („Advanced Image Settings“) befinden sich weitere Möglich-
keiten zur Beeinflussung des Bildinhaltes. 

 

Abbildung 29: Advanced Image Settings 

1. Detail 

Anhebung der Übergänge zwischen Helligkeitswerten. 
Dies bewirkt eine Verstärkung der Darstellung von Details und subjektiv einen schär-
feren Bildeindruck. 
Diese Funktion eignet sich jedoch nicht zur Korrektur vollkommen unscharfer Bilder! 

2. Detail H/V 

Gleiche Funktion wie „Detail“, aber Beschränkung der Wirkung auf die horizontale 
oder vertikale Bildrichtung. 

3. Crisp H/V 

Verstärkung der Flankensteilheit an den Rändern kontrastreicher Farbübergänge – 
getrennt in horizontale und vertikale Wirkungsrichtung. Dadurch erhält das Bild einen 
„körnigeren“ Charakter, der subjektiv als erhöhte Schärfe wahrgenommen werden 
kann. 

Hinweis: 
Setzen Sie „Crisp“ und „Detail“ nur sehr sparsam ein! Diese Funktionen machen das 
gescannte Bild bei zu kräftigen Korrektureinstellungen unter Umständen für späte-
re Verarbeitungen, insbesondere Vergrößerungen unbrauchbar. Die Wirkung dieser 
Einstellungen lässt sich nur korrekt auf einem HD-Monitor beurteilen. Bei Betrach-
tung z.B. im kleinen Vorschaufenster eines Videoschnittprogramms neigt man zum 
Überschärfen des Bildes. 

4. Whiteclip 

Begrenzung der Weißwerte im Bild. 
Hierdurch können Überstrahlungen und „ausgebrannte“ Flächen im Bild in ihrer Ge-
samtwirkung gemildert werden. Die Funktion legt einen Maximalwert für den Weiß-
punkt fest, der dann nicht mehr überschritten wird. 
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Abbildung 30: Whiteclip-Funktion 

Diese Funktion ist im Zusammenspiel mit den Auto-Light-Einstellungen [S. 36] prob-
lematisch! 

 

5. Knee 

Da in vielen Fällen ein hartes Begrenzen des Weißwertes wie z.B. durch die Whiteclip-
Funktion (s.o.) zu einem völligen Verlust der Zeichnung in hellen Bildbereichen führt, 
kann man eine Korrektur von Überstrahlungen oder „ausgebrannten“ Flächen auch 
durch die weniger aggressive Knee-Funktion erreichen. 

 

Abbildung 31: Knee-Funktion  

Hierbei erfolgt ebenfalls eine Beschränkung der Weißwerte, jedoch werden im Be-
grenzungsbereich vorhandene Helligkeitsunterschiede nicht ganz annulliert. Dadurch 
bleibt ein Minimum an Struktur in den hellen Bildpartien erhalten. 

6. Videogain 

Im Unterschied zur Light-Funktion der primären Farbkorrektur (siehe Abbildung 22 
[S.34]), die direkten Einfluss auf die Lichtstärke beim Scanvorgang nimmt, wird mit 
dieser Option das Kamerasignal verstärkt. Dies kann zusätzliche Helligkeitsreserven 
erschließen, führt aber auch zu einem Anstieg des Bildrauschens. 

7. Gamma LUT 

An dieser Stelle kann festgelegt werden, mit welcher Übertragungsfunktion die 
Lichtwerte vom Filmbild in der Kamera verarbeitet werden sollen. Dies kann linear 
(„LUT off“) oder mit einer voreingestellten Gamma-LUT („LUT on“) erfolgen. 
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6.2.5 Ton einstellen 

Im unteren Teil des Bildschirms finden Sie den Bereich „Audio“, mit dem die Zuordnung und 
Lautstärke des zu übertragenden Magnettons eingestellt werden kann. 

 

 

Abbildung 32: Audio-Einstellungen 

Im linken Bereich können Sie die Übertragungslautstärke der jeweils angegebenen Kanäle 
festlegen bzw. durch Anklicken von „Mute“ einen Kanal stumm ausschalten. 

Im rechten Teil legen Sie fest, aus welcher Quelle der Ton übertragen wird (Tonkopf, siehe 
Abbildung 1 [S.14]). 

Über den Button „EQ and Routing“ ist es möglich, einen der am varioHD vorhandenen AES-
Anschlüsse (vgl. Abbildung 2 [S.15]) mit dem analogen Ton-Ausgang zu verbinden. 

 

Abbildung 33: Audio-Routing 

Wählen Sie den AES-Anschluss, dessen Signal auf dem analogen Ausgang wiedergegeben 
werden soll. Zusätzlich können Sie jeweils mit dem Button „EQ“ einen Equalizer aufrufen. 

 

Abbildung 34: Audio-Equalizer 
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Ihnen stehen 7 frei konfigurierbare Frequenz-Bänder zur Verfügung. 

„Freq“ ist der Zentralpunkt des Frequenzbandes im Spektrum (kHz) 

Q ist die Bandbreite 

Bypass schaltet den jeweiligen Frequenzfilter ab 

Diese Einstellungen können Sie mit „Save“ für spätere Verwendungen als Datei speichern und 
über „Load“ wieder aufrufen. 

6.2.6 Die Cue-Points-Liste 

6.2.6.1 Szenenweise Korrekturen (Cue Points)  

Der varioHD ermöglicht Ihnen, verschiedene Szenen eines Films automatisch mit unterschied-
lichen Einstellungen zu scannen. 

 

Abbildung 35: Settings-Liste 

Um diese Option zu nutzen gehen Sie wie folgt vor: 

1. Fahren Sie zu einer Szene und stellen Sie alle erforderlichen Parameter ein. 
Hierbei können Sie sich zum Aufsuchen geeigneter Bilder innerhalb dieser Szene frei 
bewegen. 

2. Fahren Sie anschließend zum ersten Bild der betreffenden Szene. 

3. Klicken Sie auf „Snapshot“, um alle Einstellungen für diese Position zu speichern. 
In der Settings-Liste erscheint ein Eintrag mit laufender Nummer und der Beschrei-
bung „Settings at NNN“ (NNN = Nummer des Startbildes der Szene). Dabei werden al-
le bildrelevanten Einstellungen aufgenommen: 

· Primary Color Correction 

· Secondary Color Correction 

· Geometry 

· Advanced Image Settings 

Sie können die so gespeicherten Einträge später bearbeiten (s. 6.2.6.2 Bearbeiten von 
Cue [S.44]). 

4. Möchten Sie jedoch nur einzelne Settings für die aktuelle Position speichern, dann 
gehen Sie wie folgt vor:  

a. Ziehen Sie den Namen der gewünschten Settings-Gruppe (z.B. „Geometry“) in 
den leeren Bereich der Tabelle, um einen neuen Eintrag in der Tabelle an der 
aktuellen Position zu erstellen. Existiert bereits ein Eintrag an der aktuellen 
Position, werden die entsprechenden Settings diesem Eintrag hinzugefügt 
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(bzw. überschrieben, falls schon Einträge für die jeweilige Settings-Gruppe 
existierten). 

b. Ziehen Sie die Settings auf einen existierenden Eintrag der Tabelle, um die 
Settings dort hinzuzufügen oder zu ändern. 

Sie können die so gespeicherten Einträge später bearbeiten (s. 6.2.6.2 
[S.44]Bearbeiten von Cue [S.44]). 

5. Gehen Sie analog für alle weiteren relevanten Szenen vor. 

6. Vor dem Beginn des Scannings fahren Sie den Film vollständig zurück zum ersten Bild 
und klicken auf „Linked“. Damit ist die Settings-Liste aktiviert. 

 

Abbildung 36: aktivierte Settings-Liste 

Erreicht der Film nun während des Scannings eine in der Liste gespeicherte Position, 
dann werden alle damit verbundenen Korrektureinstellungen aktiviert. 

Die Korrektureinstellungen bleiben unabhängig davon, ob weitere Szenenwechsel folgen, 
für die nachkommenden Filmbilder solange bestehen, bis eine neue Position der Settings-
Liste oder das Ende des Films erreicht wird! 

 

Hinweis: 
Sie können die gespeicherten Cue-Punkte in zweierlei Weise nutzen: 

a) Bildposition direkt anzusteuern 
Hierzu klicken Sie auf den ōŜǘǊŜŦŦŜƴŘŜƴ 9ƛƴǘǊŀƎ ǊŜŎƘǘǎ ǳƴŘ ǿŅƘƭŜƴ αDƻ ǘƻά ƛƳ Yƻn-
textmenü. Damit können Sie die Settings-Liste auch als reinen Positionsspeicher ver-
wenden, um schnell zwischen einzelnen Positionen zu wechseln. 
Beachten Sie aber, dass häufiges Umspulen des Films diesen mechanisch belastet und 
die Gefahr von Verschmutzungen oder Beschädigungen erhöht! 

b) Settings einer bestimmten Bildposition abzurufen 
Dazu machen Sie auf den entsprechenden Listeneintrag einen Doppelklick. 
Dies bewirkt, dass sämtliche Einstellungen, die für diese Position gespeichert wurden, 
aktiviert werden und nunmehr an der aktuellen Position  

 
Alle Listeneinträge bleiben solange erhalten, bis 

· die gesamte Liste mit einem Klick auf „Clear“ gelöscht wird 

· ein einzelner Eintrag mit Rechtsklick und „Delete“ entfernt wird 

· oder die Bediensoftware beendet wird 

Nach einem Filmwechsel sollte daher die Settings-Liste gelöscht werden, es sei denn, die Ein-
stellungen treffen auch für den nächsten zu scannenden Film zu. 
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Eine Settings-Liste kann man mit „File -> Save Cue point list…“ speichern und später mit „File 
-> Load Cue point list…“ wieder laden. Die so gespeicherten XML-Dateien können für die 
Aufträge beliebig archiviert werden. 

 

Tipps zur Arbeit mit der Settings-Liste: 

1. Settings für einen Film später erneut nutzen 
Um den gleichen Film nachträglich nochmals mit den gespeicherten Settings scannen 
zu können, muss bereits beim ersten Scanning ein eindeutiges Startbild festgelegt 
werden. Gehen Sie hierzu wie folgt vor: 

- Fahren Sie an ein markantes Bild am Filmanfang. 

- Setzen Sie an dieser Stelle den Framecounter auf 0 (s. Abbildung 17 [S.28]). 

- Speichern Sie diese Position Ƴƛǘ α{ƴŀǇǎƘƻǘά ŀƭǎ Punkt in der Settings-Liste und be-
nennen Sie diesen ggf. eindeutig όǎΦ α6.2.6.2 [S.44] Bearbeiten von Cueά [S.44]). 

- Nachdem für diesen Film alle Einstellungen vorgenommen und in der Settings-
Liste festgehalten wurden, speicheǊƴ {ƛŜ ŘƛŜ [ƛǎǘŜ ǸōŜǊ αFile -> Save settings 
list…ά. Verwenden Sie dabei einen Namen, der die Zugehörigkeit zum soeben be-
arbeiteten Film sicherstellt. 

- Bei einem späteren erneuten Einlegen des gleichen Films fahren Sie zu dem o.g. 
markanten Startbild und setzen Sie dort den Framecounter wieder auf 0. 

- Laden Sie die zu diesem Film gehörige Settings-Liste. 
Nun sind alle vorherigen Einstellungen bildgenau verfügbar. 

2. Automatischen Stopp für das Scanning festlegen 
Um zu verhindern, dass nach Abschluss eines Scannings der Film vollständig von der 
Quell-Spule abrollt, sollten Sie das letzte zu scannende Bild mit in die Settings-Liste 
aufnehmen. 
Den Scan-Vorgang starten Sie dann nicht über , 
sondern mit einem Rechtsklick auf die letzte Position und anschließendem αDƻ ǘƻάΦ 
Nach Erreichen dieses Bildes stoppt der Film und kann anschließend ggf. sofort in die 
Ausgangslage zurückgespult werden. Außerdem bleiben auf diese Weise alle Verknüp-
fungen zwischen Film und Settings-Liste erhalten. 
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6.2.6.2 Bearbeiten von Cue-Points 

Sie können Cue-Points nachträglich bearbeiten. Wählen Sie dazu im Kontext-Menu (rechts-
klick) des Cue-Points „Edit“. 

 

Abbildung 37: Cue-Point bearbeiten 

Es öffnet sich der Cue-Point-Editor, mit dem Sie für den ausgewählten Listeneintrag folgende 
Einstellungen vornehmen können: 

1. Änderung des Namens 
Standardmäßig wird die Bezeichnung „Settings at <Pos.>“ eingetragen. Sie können 
hier einen charakteristischen Namen eintragen. 

2. Verschiebung der zugeordneten Bildposition („Frame“) 
Dies ist dann sinnvoll, wenn sich gezeigt hat, dass bei Aufnahme des Cue-Points in die 
Settings-Liste nicht die korrekte Bildposition (z.B. das Startbild einer Szene) ausge-
wählt worden war. 
Um den Film an die momentan bei „Frame“ angezeigte Bildposition zu fahren, klicken 
Sie einfach auf „Cue“. Befindet sich der Film an dieser Position, dann wird er direkt 

nachgeführt, während Sie mit  schrittweise die Bildnummer im Editor ändern. 

Hinweis: 
Technisch bedingt werden bestimmte Einstellungen der Settings-Liste während des 
Scan-Vorgangs nur mit einer gewissen zeitlichen Verzögerung umgesetzt. Mit dieser 
Funktion kann für einen solchen Fall eine Vorverlagerung des Einsatzpunktes möglich, 
so dass die Wirkung bildgenau einsetzt. 

3. Löschen einzelner Einstellungsgruppen 
Im Feld „Contained Settings“ finden Sie eine Liste aller Einstellungsgruppen, die die-
sem Cue-Point zugeordnet sind. Nach Auswahl eines Eintrags werden mit „Delete“ 
die Änderungen unwirksam, die diese Einstellungsgruppe an der aktuellen Bildpositi-
on bewirkt. 
Beachten Sie, dass dadurch aber auch eventuelle Einflüsse dieser Einstellungsgruppe 
aus vorangegangenen Bildpositionen nun an der aktuellen Position wirksam werden. 

Beispiel: Bei Bild 456 existieren Geometry- und Framing-Einstellungen. Nach Lö-
schung der Einstellungsgruppe „Geometry“ für dieses Bild wirken nun die 
bei Bild 123 vorgenommenen Geometry-Einstellungen weiter, bis für eine 
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spätere Position (hier 789) neue Parameter gespeichert wurden. Die Fra-
ming-Optionen bleiben davon unberührt. 

Cue-Point Geometry Framing 

 
Geometry Framing 

123     

 

    

456 
    

 

    

789     

 
    

6.3 Weitere Funktionen der Bediensoftware 

6.3.1 Arbeitsfeld-Beleuchtung 

Die Arbeitsfeld-(Filmbühnen-)Beleuchtung können Sie in der „Prepare“-Abteilung durch ei-
nen Klick auf die Abbildung der Kamera-Optik steuern. 

 

Abbildung 38: Arbeitsfeld-Beleuchtung steuern 

Der daraufhin sichtbare Schieberegler ermöglicht die Einstellung der Helligkeit. 

Mit einem Klick auf eine freie Fläche der Bediensoftware verlassen Sie diese Funktion. 

6.3.2 Speichern und Laden von Einstellungen 

Die Bediensoftware bietet unterschiedliche Möglichkeiten, um aktuelle Einstellungen vo-
rübergehend oder dauerhaft zu speichern und wieder aufzurufen. 

6.3.2.1 Kurzfristige Speicherung  

Um Einstellungen nur für die aktuelle Sitzung speichern und wieder abrufen zu können, ste-
hen Ihnen die Funktionstasten F1 bis F8 zur Verfügung. 

Drücken Sie eine dieser Tasten länger als 2 Sekunden, um die aktuellen Einstellungen zu spei-
chern. Daraufhin wird am oberen Rand des Programmfensters der zugehörige Button farbig. 
Dies signalisiert, dass die Einstellungen gespeichert und durch erneutes (kurzes) Drücken der 
Funktionstaste abgerufen werden können. 

 

Abbildung 39: Funktionstasten 

ñ 
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Alternativ dazu können Sie zum Speichern länger als 2 Sekunden auf einen der Buttons kli-
cken und zum Laden den betreffenden Button kurz anklicken. 

Wenn die flashsuite beendet wird, gehen alle so gespeicherten Einstellungen verloren. 

6.3.2.2 Langfristige Speicherung  

Zur dauerhaften Speicherung von Einstellungen bietet die flashsuite zwei Möglichkeiten: 

a) Menü File -> Save session settings…“ 
Hiermit werden alle aktuellen Einstellungen in einer Datei gespeichert, die Sie jeder-
zeit mit „File -> Load session settings…“ wieder aufrufen können. 

b) Das Symbol . 

Dieses steht in ausgewählten Rubriken zur Verfügung und erlaubt die Speicherung 
und die Wiederherstellung von Einstellungen nur dieser Rubrik. 
In Rubriken, die das Symbol nicht enthalten, können die dort eigestellten Werte nicht 
gespeichert werden. 

Bei Klick auf dieses Symbol öffnet sich folgendes Untermenü: 

 

Abbildung 40: Settings laden/speichern 

Durch Auswahl einer der aufgelisteten Settings werden die damit verbundenen Wer-
te für die jeweilige Rubrik übernommen. 

Mit „Edit“ können Sie die aktuellen Einstellungen in einer Datei ablegen oder vorhan-
dene Zustände löschen. 

Um die aktuellen Einstellungen als neue Vorgabe zu speichern geben Sie hierzu im 
nachfolgend sich öffnenden Fenster links einen Namen an und klicken Sie dann auf 
den Button . Dies speichert die Einstellungen in der Liste „Existing presets“. 

„Description“ ist ein Bereich, der bei werkseitig vorgegebenen Einstellungen eine Be-
schreibung wiedergibt. Er kann nicht geändert werden. 

Um bereits vorhandene Voreinstellungen zu löschen markieren Sie den betreffenden 
Namen in der Liste und klicken anschließend auf „Delete“ 

 

Abbildung 41: Settings speichern/löschen 
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Hinweis: 
In der LiǎǘŜΣ ŘƛŜ ȊǳƳ CŜƭŘ αbŀƳŜά ƎŜƘǀǊǘΣ ǎƛƴŘ ƛƴ ōŜǎǘƛƳƳǘŜƴ {ƛǘǳŀǘƛƻƴŜƴ ōŜǊŜƛǘǎ ba-
ƳŜƴ ŘŜǊ CƻǊƳ ά[xxx]ά ǾƻǊƘŀƴŘŜƴΦ ²Ŝƴƴ {ƛŜ LƘǊŜ 9ƛƴǎǘŜƭƭǳƴƎŜƴ ǳƴǘŜǊ ŜƛƴŜƳ ǎƻƭŎƘŜƴ 
Namen speichern, dann legen Sie diese als Vorgabe für einen bestimmten Betriebs-
modus fest. Diese Einstellungen werden automatisch übernommen, wenn der jeweili-
ge Modus eingeschaltet wurde. 

Beispiele: 

Name Einstellungen werden automatisch wirksam, wenn… siehe 

[Negative] ŘƛŜ hǇǘƛƻƴ αbŜƎŀǘƛǾŜά ŀƪǘƛǾƛŜǊǘ ǿird Abbildung 21 [S.32] 

[Positive] ŘƛŜ hǇǘƛƻƴ αbŜƎŀǘƛǾŜά nicht aktiviert ist Abbildung 21 [S.32] 

[16mm] ŀƭǎ CƛƭƳŦƻǊƳŀǘ αмсƳƳά ŜƛƴƎŜǎǘŜƭƭǘ ǿƛǊŘ Abbildung 9 [S.23] 

[35mm] ŀƭǎ CƛƭƳŦƻǊƳŀǘ αорƳƳά ŜƛƴƎŜǎǘŜƭƭǘ ǿƛǊŘ Abbildung 9 [S.23] 

6.3.3 Meta-Daten 

Der vario HD bietet die Möglichkeit, zahlreiche Werte, die während eines Scannings gemes-
sen werden, aufzuzeichnen und zu speichern. Dies gestattet eine präzise Analyse des vorlie-
genden Filmmaterials. 

Jeder gemessene Wert wird einer Position auf dem Film zugeordnet (Frame). 
Daher ist es für eine nachfolgende Auswertung wichtig, vor Beginn des Scannings eine eindeu-
tige Startposition festzulegen [S. 28]! 

Über den Menüpunkt „View -> Metadata“ können Sie diese Informationen anzeigen, konfi-
gurieren und speichern. 

 

Abbildung 42: Meta-Data 

Im oberen Teil des Fensters haben Sie die Möglichkeit, allgemeine Informationen zu den ak-
tuellen Messungen einzutragen. Standardmäßig stehen Ihnen dazu die Felder „Name“ (z.B. 
Projekt-Name) und „Operator“ (z.B. Name des Bearbeiters) zur Verfügung. Diese Angaben 
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werden im Falle einer Speicherung der Meta-Daten in der entsprechenden Datei mit abgelegt 
und ermöglichen eine genauere Zuordnung des Messwerte zu Filmen, Operatoren, Vorgän-
gen usw. 

Sie können diese Felder frei konfigurieren. 
Schließen Sie hierfür die flashsuite und öffnen Sie die Textdatei „metadatafields.txt“, die sich 
im Programm-Verzeichnis der flashsuite befindet (üblicherweise „<Programme>\flashsuite“). 
Dort tragen Sie zeilenweise die Bezeichnung der gewünschten Felder und deren Länge (Zahl 
der Zeichen) ein. 

Beispiel: 

Projekt=100  

Operator=100  

Film=100  

Rolle=4  

Daraufhin erscheinen beim nächsten Start der flashsuite im Kopf des Meta-Daten-
Fensters folgende Felder: 

 

Abbildung 43: Meta-Daten Informationsfelder 

Das Feld „Rolle“ ist auf 4 Zeichen, alle übrigen Felder auf 100 Zeichen beschränkt. 

Mit der Option „Capture metadata“ schalten Sie die Aufzeichnung von Werten ein bzw. aus. 

Die Aufzeichnung erfolgt zunächst nur im Arbeitsspeicher! Sollen die Werte dauerhaft ge-
speichert werden, dann müssen Sie zusätzlich den Button „Record“ anklicken. Ist noch keine 
Datei angegeben, in die die Speicherung erfolgen soll, dann öffnet sich ein Dialog, in dem Sie 
diese festlegen müssen. Mit Menübefehl „File -> Choose recording file…“ ermöglicht die Än-
derung des Namens und Ordners dieser Datei. Die Aufzeichnung erfolgt im XML-Format und 
kann mit geeigneter Software nachträglich ausgewertet werden. 

Sie können im Arbeitsspeicher aufgezeichnete Informationen auch nachträglich in eine XML-
Datei exportieren. Verwenden Sie hierfür das Menü „File -> Save as XML…““ 

Der Menübefehl „Clear“ löscht alle bisherigen Aufzeichnungen. 

Der vario HD registriert folgende Informationen: 

Gruppe Information Erläuterung siehe Seite 

Settings Speed Scan-Geschwindigkeit 28 

 Zoom Zoom-Stellung 29 

 Lightmode Zustand des Auto-Light-Modes 36 

 Focus Fokus-Einstellung 29 

Commanddata Crisp Einstellung für „Crisp“ 38 

 Knee Einstellung für „Knee“ 39 

 DetailH Einstellung für „Detail H“ 38 

 MainGamma Einstellung für „Gamma“ 35 

 AutoTargetLevelBlue Auto-Light-Zielwert für Blau ??? 36 

 MasterBlack Einstelung für „Black level“ 34 
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Gruppe Information Erläuterung siehe Seite 

 Detail Einstellung für „Detail H“ 38 

 AutoTargetLevelRed Auto-Light-Zielwert für Rot 36 

 Gain Einstellung für „Gain“ 39 

 WhiteClip Einstellung für „WhiteClip“ 38 

 AutoTargetLevelGreen Auto-Light-Zielwert für Grün 36 

 DetailV Einstellung für „Detail V“ 38 

Analyzing RedLight Rotanteil des Scan-Lichts --- 

 GreenLight Grünanteil des Scan-Lichts --- 

 Pitch Längenänderung des Films 
(negative Werte = Schrumpfung) 

--- 

 BlueLight Blauanteil des Scan-Lichts --- 
    

Wenn Sie eine Position der aufgezeichneten blauen Linie anklicken wird der Film an das da-
zugehörige Filmbild positioniert. 

Rote Dreiecke  innerhalb der Grafik kennzeichnen Frames, bei denen eine fehlerhafte Per-
foration erkannt wurde. 

 

Abbildung 44: Metadaten-Grafik 

Eine detaillierte Liste der als fehlerhaft erkannten Perforationslöcher können Sie sich mit Klick 
auf „Bad Perforation“ anzeigen lassen. 

 

Abbildung 45: Liste „Bad Perforation“ 

Die betreffenden Film-Positionen können Sie mit Doppelklick auf einen Eintrag anfahren. 
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Hinweis: 
Es ist nicht möglich, aufgezeichnete Grafiken zu exportieren. 
Für eine detaillierte Auswertung nutzen Sie bitte die Option zur Aufzeichnung von XML-
5ŀǘŜƛŜƴ όǎƛŜƘŜ αRecordά {Φ 48). 
Ebenso können aufgezeichnete Daten nicht nachträglich für eine Anzeige geladen werden. 

Achtung! 
Wenn Sie in den „Load“-Zustand wechseln [S. 23] gehen alle Meta-Daten verloren! 

6.3.4 Menü-Struktur 

Die Bediensoftware bietet über die genannten Funktionen hinaus folgende weitere Optionen, 
die über das Menü erreichbar sind: 

Menü Option Erläuterungen 

File Load session settings… Laden einer Settings-Liste (siehe Abschnitt 6.2.6 [S.41]) 

 Save session settings… Speichern der Settings-Liste (siehe Abschnitt 6.2.6 [S.41]) 

 Load Cue point list… Laden einer Cue-Point-Liste (siehe Abschnitt 6.2.6.1 [S.41]) 

 Save Cue point list… Speichern der aktuellen Cue-Point-Liste (siehe Abschnitt 6.2.6.1 [S.41]) 

 Connect Erneuter Verbindungsaufbau zum varioHD 

Options Bars SMPTE-Farbbalken für die Bildschirmkalibrierung generieren 
diese Funktion wird durch erneute Auswahl wieder deaktiviert 

 HID-Mapping Zuordnung von Joystick-Tasten zu Programm-Funktionen 

 

Abbildung 46: HID-Mapping 

Falls zur Steuerung des varioHD ein Joystick Verwendung findet, können Sie 
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Menü Option Erläuterungen 

den in der Spalte „Controls“ aufgelisteten Programmfunktionen eine Taste 
oder Bedienfunktion des angeschlossenen Joysticks zuordnen. 

Dies erfolgt durch Auswahl einer Joystick-Funktion aus der jeweils verfügba-
ren Liste (Spalte „Joystick“) oder durch Anklicken des Buttons „Find“ und 
anschließendes Drücken einer Joystick-Taste. 

Clear Löschen aller vorgenommenen Einstellungen 

Cancel Verlassen dieser Option ohne Änderungen 

Apply Übernahme aller bisher vorgenommenen Verände-
rungen 

Apply and close Übernahme aller bisher vorgenommenen Verände-
rungen und Verlassen dieser Option 

 Preferences Connection 

 

Abbildung 47: Optionen "Connection" 

Bei Mac-Systemen oder falls die Verbindung über den USB-Anschluss nicht 
erfolgreich war kann eine explizite Zuordnung von Ports erforderlich sein. 
Ordnen Sie hier den jeweiligen USB-Anschluss für Controller und Kamera zu. 
Sollten Sie einen MWA-flashcommander verwenden, dann kann dieser 
ebenfalls zugeordnet werden. 

Interlacing Settings 

 

Abbildung 48: Optionen "Interlacing settings" 

Mit „Field dominance“ wird die Halbbilddominanz für Interlaced-Video 

festgelegt (siehe auch „Besonderheiten bei Interlaced Formaten“ Seite 33). 
Die hier getroffene Einstellung muss mit der des späteren Wiedergabegerä-
tes oder der Verarbeitungssoftware übereinstimmen. 
Falls Sie sich nicht sicher sind, welche Einstellung korrekt ist, testen Sie 
einfach beide Einstellungen mit einer kurzen Szene mit schnellen horizonta-
len Bewegungen. Bearbeiten und komprimieren Sie das Material wie vorge-
sehen und geben Sie es auf einem Interlaced-Monitor wieder. Dann können 
Sie im Allgemeinen erkennen, welche Einstellung korrekt ist. 
Für die meisten Anwendungen ist „Upper field“ zutreffend. 

„Pulldown method“ entscheidet über die Nachbehandlung der Halbbilder, 



52 

Menü Option Erläuterungen 

falls Sie mit einer Geschwindigkeit kleiner als 25 Bilder pro Sekunde scan-
nen. In diesem Fall müssen Zwischenbilder eingefügt werden. Hierfür stehen 
zwei Methoden zur Verfügung: 

Frame insertion: Es werden stets ganze Bilder eingefügt (das Vor-
gängerbild wird wiederholt). Diese Methode ist dann geeignet, 
wenn die Scangeschwindigkeit ein ganzzahliges Teilungsverhältnis 
zu 25 fps hat (z.B. 12,5 fps) 

Field insertion: Diese Methode sollte gewählt werden, wenn die 
Scangeschwindigkeit kein ganzzahliges Verhältnis zu 25 fps dar-
stellt. In einem solchen Fall müsste der Controller eigentlich je-
weils unterschiedlich viele volle Bilder wiederholen, um die Nicht-
Ganzzahligkeit auszugleichen. Bei „Field insertion“ mischt er dage-
gen an den Schnittstellen die Halbbilder, so dass ein gleichmäßige-
rer Gesamteindruck entsteht. 

 

Abbildung 49: Frame- und Field-Insertion 

 Event-Messaging 

 

Abbildung 50: Optionen "Event Messaging" 

Mit dieser Option steuern Sie das Meldungen des varioHD für folgende 
Bedien-Situationen: 

 

Spool is running free Der Film ist nicht eingelegt oder gerissen 
bzw. das Filmende wurde erreicht 

Runmode left Run-Zustand wurde verlassen [S. 22] 

Runmode reached Run-Zustand wurde erreicht [S. 22] 

Synchronization lost Keine Synchronisation mit dem Gerät 

Synchronization reached Synchronisation mit dem Gerät hergestellt 

Diesen Zuständen können Sie bestimmte Reaktionen zuordnen, die durch 

Anklicken des Buttons  <  in die „Actions“-Liste (Mitte) übernommen bzw. 

mit  >  aus dieser entfernt werden: 

Beep 1, Beep 2 Signalton 1 oder 2 ausgeben 

Decklight on/off Bedienfeldbeleuchtung ein oder aus 

Tally blink/off Signal-Lampe blinkt oder ist aus. 
   

View Fullscreen Ein- und Ausschalten der Vollbild-Darstellung der Bediensoftware 

 Metadata siehe 6.3.3 „Meta-Daten“ [S.47] 

 Focus Lut siehe Zusatzfunktion „Focus LUT [S.30] 
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Menü Option Erläuterungen 

Help About Anzeige allgemeiner Informationen zur Bediensoftware (insbesondere der 
Versionsnummer) und Eingabe des Lizenz-Keys. 

Mit „Send“ wird der jeweils eingegebene Lizenz-Key an den varioHD über-
tragen. 

 Show tooltips Ein-/Aus-Schalten der Hilfestellungen, die angezeigt werden, wenn die Maus 
über bestimmten Elementen der Bedienoberfläche positioniert ist 

6.3.5 Tastaturkürzel 

Einige Funktionen der Bediensoftware können direkt über die Tastatur gesteuert werden. Die 
entsprechenden Tastaturkürzel sind unten aufgelistet. 

Darüber hinaus können Einstellungen, in denen eine Verschiebung von Reglern oder Linien 
erforderlich ist durch die Verwendung der Pfeiltasten deutlich präziser vorgenommen wer-
den, als mit Hilfe der Maus. Hierzu ist das betreffende Element zunächst mit einem Mausklick 
auszuwählen (zu aktivieren). Anschließend kann über die Pfeiltasten auf Ihrer Tastatur eine 
Verschiebung in sehr feinen Einzelschritten vorgenommen werden (vgl. hierzu z.B. die Hin-
weise zur Festlegung des Ausgabeformats auf Seite 30 und Seite 34). 
Zusätzlich ist ein Wechsel zwischen einzelnen aktivierten Elementen des Bildschirms auch mit 
der Tabulator-Taste (TAB bzw. Shift-TAB) möglich. 

 

Funktion Tastaturkürzel 

Play / Stopp Leertaste 

Framing (Positionierung des Bildstrichs)  ↑. und  ↓. 

Bild rückwärts und vorwärts  ←  und  →  oder  J  und  L.  

Settings-Liste: Snapshot an der aktuellen Position  S.  

 Abrufen der Settings 0 bis 9  0 … 9  auf dem Nummernblock  

 Anfahren der Cue-Points 0 bis 9  Strg +  0 … 9  auf dem Nummernblock  

Erhöhen und Verringern der Transportgeschwindigkeit  + und  –  auf dem Nummernblock  
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7 Fehlersuche 

Die im Nachfolgenden beschriebenen Fehler betreffen nur Störungen im Betriebsablauf, die 
auf bestimmte unverträgliche Ausgangsbedingungen zurückzuführen und somit vom Anwen-
der meist selbst leicht zu beheben sind. 

 

Unterlassen Sie im Zweifelsfall alle Aktivitäten, die hier nicht explizit empfohlen werden, da 
dies zum Verlust der Garantie führen kann! 

 

Bevor Sie die Service-Leistungen von MWA in Anspruch nehmen, sollten Sie auf der Grundla-
ge der angegebenen Hilfestellungen versuchen, die Ursache eines Fehlers selbst zu diagnosti-
zieren und zu beheben. Dies spart nicht nur Zeit, sondern unter Umständen auch Kosten, die 
bei Anforderung von Fachpersonal entstehen können. 

Falls ein Fehler nicht durch die beschriebenen Schritte behoben werden kann, wenden Sie 
sich bitte an unsere Service-Adresse [S. 9]. 

 

Die elektrische Absicherung des varioHD ist über Feinsicherungen gewährleistet, die inner-
halb des Gerätes angeordnet sind. Der Zugang zu diesen Bauteilen ist jedoch allein dem Ser-
vice von MWA vorbehalten. 

 

Öffnen Sie das Gerät nicht und wechseln Sie keine der vorhandenen Feinsicherungen! 

 

Dadurch können unvorhergesehene Zustände und Zerstörungen an Bauteilen auftreten und 
der Garantieanspruch verloren gehen! 

Im Folgenden werden diejenigen Fehler beschrieben, die der Anwender im Regelfall selbst 
diagnostizieren und beheben kann. Einige Fehlfunktionen oder Ausfälle könnten mitunter 
auch auf elektrische Probleme, insbesondere das Auslösen interner Sicherungen zurückzufüh-
ren sein. Wenn Ihnen auf der Grundlage der angegebenen Informationen eine Korrektur 
nicht möglich ist oder Sie sich über mögliche Ursachen und Auswirkungen nicht sicher sind, 
kontaktieren Sie bitte umgehend MWA (siehe Serviceadresse [S.9]). 
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Fehler  Ursache  Abhilfe 

varioHD lässt sich nicht steuern Kein Kontakt zum Gerät (Bediensoftware 
wurde VOR dem Einschalten des Gerätes 
gestartet oder Gerät nicht eingeschaltet) 

Überprüfen Sie, ob der varioHD eingeschaltet 
und über die USB-Verbindung mit dem PC ver-
bunden ist 
Stellen Sie die Verbindung über das Menü 
„File -> Connect“ neu her. 

Meldung „Could not connect to 
varioHD / varioHD is not valid“ 

Kein Kontakt zum Gerät (Bediensoftware 
wurde VOR dem Einschalten des Gerätes 
gestartet oder Gerät nicht eingeschaltet) 

Überprüfen Sie, ob der varioHD eingeschaltet 
und über die USB-Verbindung mit dem PC ver-
bunden ist 
Stellen Sie die Verbindung über das Menü 
„File -> Connect“ neu her. 

Rote Signal Lampe leuchtet Abhängig von den im Menü „Options -> 
Event-Messaging“ vorgenommenen 
Zuordnungen dieses Signals [S. 52] ist 
einer der folgenden Zustände eingetre-
ten: 

¶ Der Film ist nicht eingelegt, gerissen 
oder das Filmende wurde erreicht 

¶ Der Run-Zustand wurde erreicht 
oder beendet 

¶ Die Synchronisation der Be-
diensoftware mit dem varioHD ist 
hergestellt oder wurde unterbro-
chen 

Reagieren Sie ggf. entsprechend dem eingetre-
tenen Zustand 

Bediensoftware zeigt ein Ausru-
fezeichen über einer der beiden 
Filmspulen 
 

Der Film ist an der markierten Position 
aus der Führung gelaufen, weil das 
Filmende erreicht oder Film gerissen ist 

Legen Sie den Film erneut ein, klicken Sie am 
Bildschirm auf das Symbol der Signallampe, um 
diese zurückzusetzen und wechseln Sie dann in 
den Run-Zustand [S. 22] 

Film wird nicht straff gezogen - falsche Wickelrichtung in der Be-
diensoftware eingestellt 

Überprüfen Sie die Übereinstimmung zwischen 
tatsächlicher Wickelrichtung am Gerät und der 
Grafik auf dem Bildschirm. Gehen Sie vor wie in 
Abschnitt 6.1.1.5 „Run-Zustand herstellen“ 
[S.22] beschrieben. 

 - falscher Filmtyp eingestellt Prüfen Sie die Einstellung zum Filmtyp an der 
Bediensoftware [S. 23] 

Filmlauf vibriert (Run-Zustand) Film falsch eingelegt (der varioHD kann 
nicht die korrekte Filmzugspannung 
herstellen) 

Überprüfen Sie den korrekten Filmlauf. Gehen 
Sie vor wie in Abschnitt 6.1.1.2 „Filmlauf festle-
gen“ [S.20]. 

Filmlauf vibriert (Wind-Modus) Film falsch eingelegt (der varioHD kann 
nicht die korrekte Filmzugspannung 
herstellen) 

Überprüfen Sie den korrekten Filmlauf. Gehen 
Sie vor wie in Abschnitt 6.1.3 „Film spulen“ 
[S.25]. 

Film wird nicht erkannt. 
Meldung: „Perforation not 
detected / Please check film 
format settings and proper 
lacing of film“ 

- Falsches Filmformat eingestellt Stellen Sie in der Bediensoftware das richtige 
Filmformat ein. Gehen Sie vor wie in Abschnitt 
6.1.1.3 „Filmformat “ [S.21]. 

 - Perforations-Sensor falsch eingestellt Überprüfen Sie, ob der Perforations-Sensor 
entsprechend dem Filmformat richtig eingestellt 
und an der entsprechenden Position eingerastet 
ist. Gehen Sie vor wie in Abschnitt 6.1.1.3 
„Filmformat “ [S.21]. 

varioHD geht nicht in den Run- - Kein Kontakt zum Gerät Überprüfen Sie, ob der varioHD eingeschaltet 
und über die USB-Verbindung mit dem PC ver-
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Zustand bunden ist 
Starten Sie die Bediensoftware neu 

 - Film nicht oder falsch eingelegt bzw. 
Wickelrichtung falsch  

Überprüfen Sie den korrekten Filmlauf. Gehen 
Sie vor wie in Abschnitt 6.1.1.2 „Filmlauf festle-
gen“ [S.20]. 

kein Ton - Tonkopf nicht aktiviert Überprüfen Sie, ob der passende Tonkopf nach 
vorn gezogen wurde und eingerastet ist. Kon-
trollieren Sie die korrekte Lage des Films an den 
Führungsrollen des Tonkopfes. Gehen Sie vor 
wie in Abschnitt 6.1.1.4 „Ton aktivieren“ [S.21]. 

 - Film hat keine Tonspur oder diese 
enthält keine Informationen 

--- 

 - Audiospuren auf Mute geschaltet Überprüfen Sie, ob in den Settings unter „Audio“ 
die Mute-Schalter aktiviert sind [S. 40]  

Ton klingt dumpf - Tonkopf verschmutzt Reinigen Sie den Tonkopf [S. 59] 

 - Tonkopf hat keinen ausreichenden 
Kontakt zur Tonspur 

Überprüfen Sie, ob die Tonspur des Films beim 
Durchlauf am Tonkopf dicht anliegt 

kein Bild oder Bild zu dunkel - Kabel- oder Monitor-Störung Überprüfen Sie die (HD)SDI-Verbindung zum 
varioHD sowie den Monitor selbst 

 - Falsche Farbkorrektur-Einstellungen Eventuell sind die Farbkorrekturwerte so einge-
stellt, dass das Bild zu stark abgedunkelt wird. 
Stellen Sie ggf. in der Bediensoftware alle Werte 
zurück, indem Sie auf sämtliche „0“-Buttons 
klicken (siehe Abbildung 15 [S.27]) 
Arbeiten Sie zunächst mit der Auto-Light-
Funktion [S. 36]. 

 - Beleuchtungseinheit defekt oder 
nicht richtig positioniert 

Überprüfen sie, ob die Beleuchtung funktioniert 
und das Lampenhaus so weit wie möglich nach 
oben in Richtung Filmgate positioniert ist 

 - Objektiv-Deckel ist aufgesetzt Nehmen Sie den Schutzdeckel des Objektivs ab 

Bild zu hell - Falsche Farbkorrektur-Einstellungen Eventuell sind die Farbkorrekturwerte so einge-
stellt, dass das Bild zu stark abgedunkelt wird. 
Stellen Sie ggf. in der Bediensoftware alle Werte 
zurück, indem Sie auf sämtliche „0“-Buttons 
klicken (siehe Abbildung 15 [S.27]). 
Arbeiten Sie zunächst mit der Auto-Light-
Funktion [S. 36]. 

 - Umgebungslicht zu hell Schließen Sie die Abdeckhaube 
(siehe Abbildung 1 [S. 14]) 
Löschen Sie helle Raumbeleuchtungen oder 
dunkeln Sie den Raum zusätzlich ab 

Bild verzerrt - Anamorpher Modus eingeschaltet, 
obwohl das Bild selbst nicht 
anamorph aufgenommen wurde 

Schalten Sie den Modus „Anamorph“ aus (siehe 
Abbildung 21 [S.32])  

 - Videoformat SD 16:9 ausgewählt, 
aber der Monitor ist auf 4:3 einge-
stellt oder umgekehrt 

Wählen Sie ein passendes Videoformat (siehe 
Abbildung 21 [S.32]) 

Bild steht auf dem Kopf Film war nicht auf Anfang gerollt Legen Sie den Film aus und rollen Sie ihn zurück 
auf Anfang 
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Bild ist seitenverkehrt „Mirror“ aktiviert oder der Film wur-
de/konnte nicht seitenrichtig eingelegt 
werden 

Schalten Sie die Funktion „Mirror“ [S. 33] 
ein bzw. aus 

Bild kann nicht scharf gestellt 
werden 

schlechte Bildqualität auf dem Film Verschieben Sie das Filmbild für die Einstellung 
der Schärfe mit der „Pan“-Funktion [S. 29] so 
weit, dass Teile der Perforation sichtbar werden 
und stellen Sie auf diese scharf ein 

Fehler im Bild - Optik oder Beleuchtung verschmutzt 
(erkennbar an „unscharfen“ Bildfeh-
lern) 

Reinigen Sie die Optik und die Beleuchtungsein-
heit wie ab Seite 60 beschrieben 

 - Kabel defekt Prüfen Sie alle Übertragungskabel vom varioHD 
bis zum Monitor bzw. Rekorder und wechseln 
Sie diese (probehalber) aus. 
Im Zweifelsfall kontaktieren Sie MWA. 

 - Kamera-Einheit defekt Kontaktieren Sie MWA! 

 - Interlaced-Modus mit falschen Halb-
bild-Einstellungen 

Wechseln Sie die Einstellungen zur Handhabung 
von Halbbildern im Interlaced-Modus [ S. 51] 

 - Pixelfehler am Monitor Vergleichen Sie ein gescanntes Bild mit der 
Darstellung am Monitor. Ist der Fehler im ge-
scannten Bild nicht erkennbar, dann liegt ein 
Defekt am Monitor vor 

 - Film verschmutzt reinigen Sie den Film 

Bildstand schlecht - Film läuft rückwärts Der Film darf im Scan-Modus nur vorwärts (von 
links nach rechts) laufen 

 - Perforation fehlerhaft Versuchen Sie, mit höherer Toleranz für die 
Erkennung der Perforation zu arbeiten [S. 25] 

 - falsche Scangeschwindigkeit Stellen Sie für das Scanning nur Geschwindigkei-
ten ein, die nicht mit einem Stern (*) gekenn-
zeichnet sind [S. 28] 

Bild „pumpt“ (rhythmische 
Änderung der Helligkeit) 

Justage der Optik wurde verstellt (Hel-
ligkeitskorrektur überfordert) 

Prüfen Sie, ob die Blende auf 5,6 steht. 
Im Zweifelsfall kontaktieren Sie MWA 

Bild reagiert nicht auf Geome-
trie- und Farb-Einstellungen 

Ausgabemonitor/Recorder mit falschem 
(HD)SDI-Ausgang verbunden 

Verbinden Sie den Monitor mit dem (HD)SDI-
Ausgang 1 oder 2 

Bilder werden doppelt gescannt Scangeschwindigkeit liegt unterhalb von 
25fps 

Lesen Sie die Hinweise zu Besonderheiten bei 

Interlaced Formaten auf Seite 33 

Messwerte (Metadata) werden 
nicht aufgezeichnet 

- Aufzeichnung deaktiviert Aktivieren Sie die Option „Capture Metadata“ 
[S. 47] 

 - keine Aufzeichnungsdatei angegeben Legen Sie eine Datei fest, in der die Messwerte 
aufgezeichnet werden sollen. Speichern Sie ggf. 
vorhandene Daten nachträglich [ S. 48] 

Bildzähler stimmt nicht mehr Gerät wurde zwischenzeitlich zurückge-
setzt (Load-Stop-Schalter oder Not-Halt 
nach Transportfehler) 

Fahren Sie den Film an den Anfang und registrie-
ren Sie das Startbild neu [S. 28] 
Bedienen Sie die Load-Stop-Schalter nur, wenn 
der Film ausgelegt werden soll 

Film wird zerkratzt - Verschmutzung in der Filmführung! Kontrollieren Sie alle Rollen (insbesondere die 
Führungsrollen des evtl. aktivierten Tonkopfes) 
und reinigen Sie diese gegebenenfalls 
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 - Film läuft über eine Kante! Prüfen Sie, ob der Film einwandfrei durch alle 
Führungen hindurch läuft 

Film reißt Zugspannung zu groß Verringern sie die Zugspannung [S. 24] 
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8 Wartung und Instandhaltung 

Der varioHD ist so konzipiert, dass er weitgehend wartungsfrei arbeitet. Um eine ein-
wandfreie Funktion zu gewährleisten, sind lediglich folgende regelmäßige Arbeiten 
auszuführen: 

- Schmutz und Ablagerungen auf den Rollen im Filmlauf entfernen (mindestens 
wöchentlich). Hierzu kann Druckluft oder ein fusselfreier Lappen verwendet wer-
den. Eine intensivere Reinigung des Filmlaufs ist nur erforderlich, wenn sich auf 
den Rollen Ablagerungen gebildet haben, die sich so nicht entfernen lassen. Ver-
wenden Sie hierfür ausschließlich Isopropanol und einen fusselfreien Lappen. Auf 
keinen Fall sollten Wattestäbchen oder Papiertücher zum Einsatz kommen! 

- PTR-Filmreinigungsrollen 
Wenn Sie diese Rollen verwenden, dann sollten diese im Idealfall vor jedem 
Scanning gereinigt werden, spätestens jedoch, wenn deutlich sichtbare Schmutz-
spuren auftreten. Verschmutze Flächen auf diesen Rollen können keinen Staub 
vom Film aufnehmen. Im schlimmsten Fall werden sogar Partikel an den Film 
wieder abgegeben. 

Achtung! 
Reinigen Sie diese Rollen nur mit der Hand in lauwarmem Wasser! 
Verwenden Sie niemals Lösungs- oder Reinigungsmittel, Bürsten oder Lappen! 
Dies würde die Beschichtung zerstören, die Haftfunktion außer Kraft setzen und 
durch entstehende Rauigkeiten die Gefahr von mechanischen Beschädigungen 
auf der Filmoberfläche hervorrufen. 

Trocknen Sie die Rollen anschließend an der Luft ohne Zuhilfenahme eines Tu-
ches. 

Hinweis: 
Die PTR-Rollen können auf den Achsen nach vorn versetzt bzw. um 180° gedreht 
aufgesteckt werden. Dadurch ist es möglich, weitere Filme über bislang ungenutz-
te Flächen der Reinigungsrollen laufen zu lassen und Reinigungsaufwand zu spa-
ren. 
Achten Sie aber beim Verschieben der Rollen darauf, dass der Film stets genügend 
Lauffläche hat und nicht von der Rolle läuft. 

- Capstan 
Die Umlenkrolle am Capstan sollte regelmäßig, idealerweise vor jedem Scanning 
gereinigt werden. Andernfalls kann es durch Schmutzablagerungen zu einer Ver-
ringerung der Haftreibung zwischen Rolle und Film kommen, wodurch Fehler bei 
der Synchronisierung und Bildzählung entstehen. Verwenden Sie dafür nur feuch-
te, fusselfreie Tücher. In Ausnahmefällen kann auch Isopropanol eingesetzt wer-
den. 

- Lichttonkopf 
Prüfen sie vor und während jedem Scanning, ob die Führungsrollen (Abbildung 7 
[S.22]) frei von Staub und anderen Verschmutzungen sind. Technisch bedingt ist 
es erforderlich, dass die Führungsrollen des Tonkopfes auf dem Film aufliegen. 
Dadurch können geringste Verunreinigungen die Filmoberfläche beschädigen. 
Insbesondere Haare und ähnliches, die sich um die Rollen wickeln, können zu 
Längsschrammen oder Druckbelichtungen führen. 
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- Magnettonkopf 
Hier gilt das zur Reinigung des Lichttonkopfes gesagte in analoger Weise. 
Zusätzlich ist zu beachten, dass der Film in direktem Kontakt über den Tonkopf 
geführt wird. Dadurch kommt es hier schnell zu Ablagerungen, die sich im Ext-
remfall als Verschmierung zeigen. 
Reinigen Sie den Tonkopf daher ggf. mit Isopropanol unter Zuhilfenahme eines 
fusselfreien Lappens. 

- Optik 
Die äußere Linse der Kamera sollte regelmäßig auf Staubablagerungen unter-
sucht werden. Diese können Abbildungsfehler erzeugen oder sich selbst im Bild 
abzeichnen. Stellen sie für eine Reinigung den Zoom auf einen Maximalwert 
[S. 29], damit die Kamera ganz nach unten fährt. Lösen sie anschließend die Arre-
tierungsschraube an der rechten Seiten der Kamera-Abdeckung und schieben Sie 
diese ganz nach oben (siehe Abbildung 1 [S.14]). 
Sie können nun mit einem optischen Pinsel, einem weichen, fusselfreien Tuch 
oder gereinigter technischer Druckluft die Oberfläche reinigen. 

Atem- oder Raumluft  ist hierfür ungeeignet, weil sich die enthaltenen Verun-
reinigungen und die Feuchtigkeit auf den optischen Bauteilen niederschlagen! 

Verwenden Sie niemals Lösungsmittel! Dies führt zu einer irreversiblen Beschä-
digung der Oberflächenveredelung. Hartnäckige Verunreinigungen können mit 
einem angefeuchteten, weichen und fusselfreien Lappen gelöst werden. 

- Lichtquelle 
Halten Sie das Lampenhaus fest, lösen sie die Arretierungsschraube an der linken 
Seite und verschieben Sie das Gehäuse bis zum untersten Anschlag. Anschließend 
können Sie die Glasoberfläche unter Verwendung gereinigter technischer Druck-
luft, ersatzweise mit einem Reinigungstuch für optische Geräte von Staub und 
Ablagerungen befreien! Hartnäckige Verschmutzungen können auch mit Isopro-
panol gelöst werden. Fahren sie anschließend das Lampenhaus wieder bis zum 
Anschlag nach oben und arretieren Sie es. 

- Lüfter am Filmgate 
Reinigen Sie diesen nur, wenn das Filmgate ausgebaut ist [S. 19]. 
Verwenden sie nur gereinigte technische Druckluft. 

- Fotodiode am Perforations-Sensor [S. 21]. 
Eine Reinigung ist hier nur erforderlich, wenn bei der Registrierung von Perforati-
onslöchern dauerhaft Fehler auftreten. Verwenden Sie für die Reinigung nur fus-
selfreie Lappen oder gereinigte technische Druckluft. 
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Achtung! 
Führen sie Reinigungsarbeiten niemals im laufenden Betrieb durch! 
Als Folge davon können mechanische oder elektrische Beschädigungen am Gerät sowie 
erhebliche gesundheitlich Verletzungen auftreten. 

Weitere Arbeiten sind im Rahmen einer Pflege oder Wartung nicht erforderlich bzw. nur 
durch MWA auszuführen. 

Insbesondere sollten Sie folgendes beachten: 

- Ölen Sie keine Rollen und Lager! 

- Öffnen Sie das Gerät nicht! 

- Lösen und befestigen Sie keine Schrauben oder sonstige Befestigungen am Ge-
häuse und im Filmlauf! 

Im Zweifelsfall wenden Sie sich bitte an die Service-Adresse (Seite 9). 
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Stichwortverzeichnis 

 

(HD)SDI  5, 13, 15, 16, 17, 18, 32, 56, 57 

1080i50  32 

1080p25  32 

16:9  32, 56 

16mm  21, 47 

35mm  21, 47 

4:3  32, 56 

720p50  32 

Accurate  25 

Add Focus Point  31 

Advanced Image Settings  27, 38 

AES/EBU  13, 15, 16, 18, 40 

Analog  15 

Analog IN  15, 18 

Analog OUT  15, 18 

Anamorph  33 

Audio  15, 18, 27, 40 

Auto Light  36 

Off  36 

automatische Optimierung  36, 37 

automatische Voreinstellungen  23, 33, 41, 
47 

AutoTargetLevelBlue  48 

AutoTargetLevelGreen  49 

AutoTargetLevelRed  49 

Bad Perforation  49 

Bildausschnit  29 

Bildstrich  29, 53 

Bildzähler  24, 25, 28, 57 

Biphase  siehe GPIO 

Black  34 

Black and White  32 

BlueLight  49 

Brightness  36 

Button 0  19 

Capstan  14, 24, 25, 59 

Capture metadata  48 

Cascade  36 

Clear  42, 48 

Color  36 

Color Correction  27 

Commanddata  48 

Connection  51 

Contained Settings  44 

Could not connect to …  55 

Crisp  48 

Crisp H/V  38 

Cue  28, 44 

Cue point list  27, 50, 53 

Cue-Point-Editor  44 

Delete  42 

Description  46 

Detail  38, 49 

Detail H/V  38 

DetailH  48 

Details  30 

DetailV  49 

EQ and Routing  40 

Equalizer  40 

Existing presets  46 

EZ Focus  29 

Field dominance  51 

Field insertion  51 

Fields  33 

File  43, 46, 48, 50 

Choose recording file…  48 

Connect  50 

Load Cue point list…  43, 50 

Load session settings…  46, 50 

Save as XML…  48 

Save Cue point list…  43, 50 

Save session settings…  46, 50 

Filmantrieb  siehe Capstan 

Filmformat  23 

Filmgate  14, 17, 19, 25, 56, 60 

Beleuchtung  45 

Filmgate fan  25 
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Filmreinigungsrolle  siehe PTR 

Filmspule  20 

Fit  29 

flashcommander  51 

flashsuite  27, 46, 48 

Focus  30, 48 

Focus LUT  30 

Fotodiode  60 

fps  13, 28, 33, 51, 57 

Frame insertion  51 

Frequenzband  41 

Funktionstasten  45 

Gain  37, 49 

Gamma  35 

Gamma LUT  39 

Genlock  15, 16 

Geometry  27 

GPIO  15, 16, 18 

Graphical view  31 

GreenLight  49 

GUI  27 

Halbbild  33 

HD  5, 13, 15, 16 

Headroom  37 

Helligkeit  34 

Help  53 

About  53 

Show tooltips  53 

Histogramm  36 

Hue  38 

Interlaced  33 

Interlacing Settings  51 

Joystick  50 

Kamera  17 

Knee  39, 48 

Laser  siehe Perforations-Sensor 

Leistung  11 

Lichtquelle  14, 33, 34, 60 

Light  35 

Lightmode  48 

Linked  42 

Lizenz-Key  53 

Load  24, 25, 50 

Load-Stop-Schalter  14, 22, 23, 24, 25, 57 

Lüfter  60 

LUT  5, 30, 31, 39 

Open  31 

Save  31 

LUT off  39 

LUT on  39 

LUT Points  31 

Mac  51 

MainGamma  48 

Master  38 

MasterBlack  48 

metadatafields.txt  48 

Mirror  33 

Mute  40 

Name  47 

Negative  33, 47 

Negativ-Scannen  33 

Netzanschluss  11 

Netzschalter  15 

Operator  47 

Optik  14, 60 

Options  33, 50 

Bars  50 
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